Nutrient Management for Maryland
Professional Edition
University of Maryland College Park
College of Agriculture and Natural Resources

NuMan Pro 3.0
© 2000
University of Maryland
All rights reserved
# Table of Contents

II. Welcome to NuMan Pro 3 .......................................................... 5

III. Getting Started ............................................................................. 6

IV. Farmer and Consultant ................................................................. 8

V. Field .............................................................................................. 10

VI. File Management ........................................................................... 14
   A. Naming Files .............................................................................. 14
   B. Saving Files .............................................................................. 14
   C. Opening Files ........................................................................... 15
   D. Creating New Field Files ......................................................... 15
   E. Adding Blank Fields ................................................................. 15
   F. Copying Core Information to a New Field ................................. 16
   G. Appending Field Records ......................................................... 16
   H. Deleting a Field ....................................................................... 17
   I. Navigating Between Fields ........................................................ 17

VII. Soil ............................................................................................ 19
   A. Entering Soil Test Results ....................................................... 19
   B. Receiving and Renaming Electronic Soil Analysis Reports .......... 20
   C. Importing Soil Analysis Data .................................................. 21
      1. Importing Analysis Data for a Single Field ......................... 21
      2. Importing Analysis Data for Multiple Fields at the Same Time .... 23

VIII. Organic Materials ..................................................................... 26
   A. Creating the Organics List ....................................................... 26
   B. Manure Generation .................................................................. 30
      1. Published Manure Generation Estimates for Integrated Poultry 33
      2. Published Manure Generation Estimates for All Other Animals 37
      3. Manual Method ................................................................. 42
XV. Appendix - Menus................................................................................................................ 104

XVI. Appendix - Keyboard Shortcuts ..................................................................................... 108

XVII. Appendix – Glossary........................................................................................................ 110

XVIII. Appendix – Technical .................................................................................................... 114

A. Updating from older versions .......................................................................................... 114

B. Converting NuManMD Files ............................................................................................ 115

C. Importing PSI Data .......................................................................................................... 116

D. Memory/Allocation of RAM ............................................................................................ 117
II. Welcome to NuMan Pro 3

"Nutrient Management for Maryland Professional Edition" (NuMan Pro 3.0) is a software program that provides field-specific recommendations for environmentally sound utilization of commercial fertilizer, animal manure, and other organic materials such as biosolids. It is based on research and Extension recommendations appropriate to the Mid-Atlantic region and meets all regulatory requirements of the State of Maryland.

The program incorporates information about soils, management practices and potential yield to estimate the amount of nutrients a crop will need. It quantifies the nutrient value of manure and other organic by-products, and utilizes the Phosphorus Site Index (PSI) to develop plans that reduce risk of nitrogen and phosphorus losses from leaching and runoff.

In order to develop a nutrient management plan, you will need to collect information about the farms, soils, crops, nutrient sources, and history. Soil test results can be electronically imported from local laboratories, but most other data will need to be manually entered into NuMan Pro 3.0. Data collection forms and other resources for developing plans are available on the University of Maryland's Agricultural Nutrient Management Program web site under the section entitled Plan Writing Tools.
III. Getting Started

Open NuMan Pro by:

A) clicking on the desktop icon  
   OR

B) clicking on Start\Programs\UMCP\NuMan Pro

The first line across the top of the screen is the Title Bar with the NuMan Pro icon and name. After files have been created, the name of the currently opened file and the farmer will appear in the Title Bar.

The second line is the Menu Bar. Drop-down menus will appear when clicking on one of the icons with the mouse cursor, then allowing it to hover over any of the other icons (except Window).
The third line is a combination Tool Bar and Navigation Bar. On the left side, the Tool Bar contains icons for the most commonly used functions. If the mouse cursor is allowed to pause over the Tool Bar icons, the name of the tool will appear just below it and a brief description of its function will appear at the bottom of the screen.

To the right is the Navigation Bar which is used to identify and move between fields. Navigation is described in more detail in Section VI. I Navigating Between Fields.

Below the Tool Bar and the Navigation Bar is the Nutrient Management work area. The work area has tabbed pages that indicate the type of information to be entered. NuMan Pro has three functional views: Nutrient Management, Phosphorus Site Index and Organic Balance.

In the default Nutrient Management work area, a blank form will open with tabs labeled Farmer and Consultant, Field, Soil, Scenarios, History and Recommendations. The status of the tabbed sections is indicated by ✗, ✓ or ☺. When starting a new file, all the tabs requiring data will be marked with ✗ (red x) to indicate that information is needed. When a section is complete, the ✗ will change to a ✓ (green check mark). At times there may be a ☺ (yellow circle) which means some data are missing, but it is ok to go on to the next stage without the desired information.

There is no Auto-save or step-by-step undo in NuMan Pro, so save frequently. Initially, until comfortable with the program, it is recommended to save each tab (Farmer and Consultant, Field, Soil, Scenarios, History, Recommendations) after it is completed.
IV. Farmer and Consultant

Using the mouse, click on the Farmer and Consultant tab to enter contact information for both. The text labels for required information are shown in bold.

Enter the Farmer information on the left. The Farmer ID is an optional piece of information. Enter the Maryland Department of Agriculture (MDA) party ID, if known; otherwise leave blank.

A nutrient management consultant has an individual Certification Number and operates under a License Number.

Consultant information can be saved and entered automatically for future use. Go to the File menu and click on Save Consultant Info or use the keyboard combination Ctrl+U. A dialogue box will appear, which allows for naming and saving the consultant information file. The process can be repeated for multiple consultants using a single computer. Note the *.nmc extension is used for nutrient management files.
To retrieve consultant information, click the Insert button at the bottom right corner of the Farmer and Consultant page. Highlight the desired file name and select Open. Consultant information in the selected file will be inserted into the appropriate boxes, overwriting any previous consultant information.

When finished entering all Farmer and Consultant information, the tab marker at the top will change from ✗ to ✓ and the user can proceed to the Field page.
V. Field

Identification information for all fields is entered on the Field page. One field equals one management unit. Drop-down lists are provided for ease of selecting County, Watershed, Mapunit Symbol and Region. The other data must be entered manually.

County, Tract, Field ID, Account ID, and Watershed ID are required information. If there is difficulty in determining Account ID or Watershed ID information, contact the regional UME or MDA nutrient management specialist for assistance. It is necessary to find the exact location of the field to determine the watershed in which it is located and the Mapunit Symbol which reflects the predominant soil type within the field. The Mapunit Symbol is not necessary for a nutrient management recommendation, but is required for a Phosphorus Site Index (PSI) evaluation.

The combined information entered for County, Tract, and Field ID will create a unique identity for each field.

Use the drop-down box to select the County in which the field is located. This may be a county different from the owner’s or operator’s address.

Enter the Tract (or farm) name or number, using the farmer’s FSA/NRCS field designations whenever possible.

Enter the Field ID, using the farmer’s FSA/NRCS field designations whenever possible. The Field ID may be alphabetical or numeric and can include hyphens and underlines.
Account ID numbers can be located on a tax bill or property assessment. For additional information see the Agricultural Nutrient Management Program (ANMP) web site section on Finding Tax Account ID Numbers or the Maryland Department of Assessments and Taxation Real Property Data Search.

Some fields managed as a single unit may have multiple, or Supplemental Account IDs. Click the Supplemental ID button at the upper right of the Field page to display space for up to five additional ID numbers.

Select Watershed ID from the drop-down box and the watershed name will appear. Watershed ID can be determined from county maps available from MDA.

Mapunit Symbol is based on the dominant soil type in a field and can be determined from the NRCS Web Soil Survey or a traditional hard copy soil survey. Expected yield goals are also available in Web Soil Survey if a farmer does not have field-specific yield records. When the county is selected, the computer will automatically provide the appropriate list of soil map units. The soil map unit is not required for a nutrient management recommendation, but is required for a PSI evaluation.

Region is utilized for lime recommendations. Select Coastal Plain for all counties on the Eastern Shore (except northwest Cecil County), Southern Maryland and areas East of Interstate 95. Select Piedmont for Central Maryland; and Mountain for properties from the Blue Ridge Mountains in Frederick County and areas west.

Use the drop-down box to select the First Year a plan was ever written for the farm.

Enter the field size in acres or 1,000 sq.ft., using the Area button to toggle between the two units of measurement.
In the bottom left is the **Phosphorus Site Index (PSI)** icon. A PSI evaluation is required for any field with a Fertility Index Value for Phosphorus (FIV-P) of 150 or above, but this information will not be available until after soil test results are entered on the next tab.

Before soil tests are entered, PSI is off and the icon is blue with a red slash.

Once soil test results are entered:

- PSI will be **disabled (turned off)** automatically for fields **below** 150 FIV-P and the icon will remain blue with a red slash (unless manually enabled).

- PSI will be **enabled (turned on)** automatically for fields **at or above** 150 FIV-P and the icon will be blue without the red slash. When PSI is enabled, indicate in the pop-up box whether additional phosphorus (fertilizer or organic) will be applied.

- The PSI evaluation may be manually toggled on or off by clicking on the icon.

- At the lower left-hand corner of the page, when applicable, will be a control for disabling the **Phosphorus Site Index** for those fields with a special case management scenario such as pasture where P-bearing material will not be applied.
The Revert button on the Field page acts as a master revert and will return all data on all pages of the current field to a pre-edit condition providing no other field has been displayed and the edits have not been saved.

Revert buttons on all other pages affect only the data on that particular page. Reminder messages may appear on this and other pages to ensure that the user wishes to revert to an earlier condition.

After entering field information, Save the file as described in the next section.
VI. File Management

The long term file management needs of an individual farmer will be very different than those of a nutrient management consultant who may work for many farmers in several counties. Give some consideration to specific needs and what will be an appropriate file naming and management system before many files are created. Choosing a file naming convention, along with an effective directory scheme, will greatly reduce future file management problems and increase the efficiency of locating stored data.

A. Naming Files

Files can be given names that reflect the information contained within them such as Farmer Name, Farm Name, and Year (Jones_New-Farm_2004). Any combination of letters, numbers, underscores and dashes is acceptable, but do not use symbols. The program will assign the file's extension automatically.

Use directories and sub-directories to simplify file management. If the client base spans multiple counties, creating sub-directories by county may be helpful. Creating additional sub-directories inside these directories (perhaps to designate a year) is also a way to identify which files can be safely deleted when the files are no longer needed. If more than one consultant will be using the same computer, directories with each user's name may be created.

B. Saving Files

It is a good practice to save files regularly during editing to ensure that work is not lost. Closing a file without saving will cause all information since the last save to be lost.

**NuMan Pro does not have an Auto-save function or timed backup, so frequent manual saves are important.**

Save the currently opened and edited file at any time by clicking the **Save** button on the Tool Bar (or press **CTRL+S**).

NuMan Pro employs the **Save As** dialogue instead of automatically saving the file to prevent mistakenly overwriting or misnaming a file. The name of the currently opened file is the default name in the **File Name** box. Make any changes to the file name and click the **Save** button.

If the file name already exists prior to saving, the program will prompt the user to confirm the action prior to overwriting the existing file. Click **OK** to overwrite the existing file with the same name.

The default directory for saving files is the **Field** directory within NuMan Pro.


C. Opening Files

Click the **Open** icon on the Tool Bar (or **CTRL+O**) and the **Open File** dialogue will appear. Navigate to the directory containing the NuMan Pro files. *(Note: The Field directory in NuMan Pro should be the default unless changed by the user.)* Double-click on the desired file (or place the cursor on the file and click **Open**).

After NuMan Pro opens the file, the **Title Bar** at the top of the NuMan Pro screen will change to display both the name of the file and the name of the farmer designated in the file. This information is an easy reminder as to the currently opened file.

The farmer and consultant data will be displayed in the Farmer and Consultant page and any information previously entered on the first field in the file will be shown in the remainder of the data pages. The status indicators on the page tabs will reflect the completeness of required data that have been previously entered. The tab indicators do not indicate accuracy of data entered, only whether data entry has been completed. Click on a page tab (or use the keyboard combination **CTRL+PGDN/PGUP**) to navigate the displays for the different pages.

D. Creating New Field Files

Navigate to the Tool Bar and click on the **New** icon to create a new empty field file. Opening a new file without saving first will cause any **unsaved data to be lost**. The file will have no descriptive information for the farmer and will have one blank field. Information for both the farmer and the first field should be entered before continuing.

When an existing file is opened, the information for the farmer and/or the first associated field will be displayed and may be examined or modified. In both cases, multiple fields may be grouped together in one file associated with one, and only one, farmer.

E. Adding Blank Fields

To add a new blank field, click the **Add Field** icon on the Tool Bar (or press **F9**, or **Edit, Add Field**). The program will switch to the **Field** page where the County, Watershed ID, Mapunit Symbol and all remaining text boxes will default to blanks.

The **Field Number** box on (or underneath) the Tool Bar will show that the number of fields has increased by one (1) and the number of the field just added will be indicated as the currently active field. In addition, the **Parcel** box will contain no Tract or Field ID information. Complete the Account ID, Tract and Field ID before continuing with the program. As the Tract and Field ID are entered, the Parcel box will reflect the new data. Choose the correct County, Watershed ID and Mapunit Symbol, as applicable.
F. Copying Core Information to a New Field

To add a field to a file and simultaneously copy the core identification information (Account ID, County, Tract and Watershed ID) from an existing field in the currently open file, follow these steps:

- Navigate to, and display, the Field page of the source field. Click in the Field ID box.

- Press F3 (or Edit, Copy Field) and the core information, of this field, will be inserted into the Field page of a newly created field. This new field will be at the end of the existing file. The Field Number box on (or underneath) the Tool Bar indicates the number of fields has increased by one (1) and the number of the field just added will be shown.

- Add the appropriate field ID, specify the acreage, and change the mapunit symbol each time a field is added.

- The Parcel box displays the Tract, but no Field ID. The Field ID and Mapunit Symbol should be completed before continuing with the program. As the Field ID is entered, the Parcel box will reflect the new data.

- No information on any other page will be copied.

G. Appending Field Records

From time to time, it may be necessary to add/append one or more fields to an existing NuMan Pro (.nmp) file. To add or append fields located in an existing (.nmp) file, follow these steps:

- Go to the Select Field Records function, found on the File menu. In the Select Records dialogue, highlight the desired field record(s), copy to target list and then click Append.

- The Save As dialogue opens and a list of available (.nmp) files is presented. Highlight the desired listing to append the field records to that file, and then click Save. A message will warn that the file selected already exists and asks if the user would like to overwrite this file. Choose yes and the field records and their information will be appended to that file. When that file is next opened, the newly appended field(s) will appear in the field list and will be at the end of the numerical order.

When field information is appended, the field history information and any PSI data will accompany the field record. However, the field record will not contain the organics list nor any information on organic source application. After confirming that the desired field records have been appended to the target file, delete those fields from the original file.
H. Deleting a Field

Navigate to, and display, the Field page of the field to be deleted.

- Click the Delete Field icon on the Tool Bar (or press F11). A dialogue box will confirm the intention to delete the selected field.

- Click Yes (or Enter/Return) to delete the field.

- Click No (or the Right Arrow, then Enter/Return) to cancel the deletion and return to NuMan Pro.

I. Navigating Between Fields

There are several ways to navigate between fields within a file. One simple way is to use the function keys (F5 = first field, F6 = previous field, F7 = next field and F8 = last field).

Another way is to use the Field Navigation Buttons on the Tool Bar. The middle pair of buttons advances or reverses one field at a time in the order the set of fields was created. The outer buttons jump to the beginning or the end of the set of fields.

The Navigation Bar, on or beneath the Tool Bar, allows direct selection without the need to individually scroll through fields. The Field Number box at the left end of the Navigation Bar displays the order number of each field and the total number of fields in the currently opened file. For example, field number 5 out of 14 fields.

To display information for a specific field, place the cursor in the left box, type the number of the desired field, and press Enter to display that specific field's information in the Data Pages.

To the right of the Field Number box is the Parcel drop-down list. The Parcel list is used to display field identification information in either combined or separated form. Select View, then Separate Navigation to toggle between the two views.

- When the Parcel list is in a combined format, all tracts and fields are listed together, preceded by their county abbreviation. This format works best when there is a single tract with a small number of fields (<20).
When the Parcel list is in **separated** format, county abbreviations are not included. The list of tracts will be on the left and the list of fields will be on the right. This format is preferred when there are many fields in multiple tracts.

When a small number of fields (e.g. 15-20 fields) exist in a file or all fields are in a single tract, it may be more convenient to use the Parcel drop-down list box in a combined format. When a large number of fields (e.g. more than 20 fields) exist in 3 or more tracts, it may be more convenient to display the field identification information using the Tract and Field drop-down list boxes in a separated format. The drop-down lists may be toggled between the two formats by clicking the Separate Navigation option on the View menu.

**Navigate within the currently active set of fields**, follow these steps:

- Open a list by clicking the mouse on the small arrow at the end of the box.
- Scroll to highlight the desired field listing and select it by clicking the mouse on the listing.
- The lists are sorted alphanumerically. When displayed in a separated format, the field list will display only those fields associated with the displayed tract.
VII. Soil

A. Entering Soil Test Results

Soil test results are a critical part of nutrient management planning. Not all laboratories use the same procedures or reporting methods so it is important to properly identify which laboratory and analysis method was used for a particular test. Lab results are then converted to Maryland Fertility Index Values (FIV) in the yellow boxes. Incorrect selection will result in improper conversions and invalid recommendations.

<table>
<thead>
<tr>
<th>Laboratory</th>
<th>Test Date</th>
<th>Soil Texture</th>
<th>Test Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>A &amp; L, VA, Bray</td>
<td>10/1/09</td>
<td>Silt Loam</td>
<td>2494</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>pH</th>
<th>O.M.</th>
<th>P</th>
<th>K</th>
<th>Mg</th>
<th>Ca</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.8</td>
<td>2.2</td>
<td>102</td>
<td>122</td>
<td>115</td>
<td>562</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conversion to FIV</th>
<th>B</th>
<th>Cu</th>
<th>Mn</th>
<th>Zn</th>
<th>SO4-S</th>
</tr>
</thead>
<tbody>
<tr>
<td>pH 5.80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O.M. 2.20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P 178.17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>K 77.18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mg 98.35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ca 56.60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Select the appropriate laboratory from the drop-down box. Not all lab names appear at once, so it may be necessary to scroll down.

- Enter the soil texture. This can be obtained from a previous soil test report (University of Maryland AGNR’s Soil Testing Lab routinely reported soil texture), from the “texture by feel” method or from the soil texture of the A horizon of the dominant soil map unit of the field.

- Enter the date of the test and the test number for the individual soil sample.

- Soil analysis data may be manually input or electronically imported into the white boxes (yellow before first entry). See the section on importing data.

- Do not put a zero into any box unless the report value is, in fact, zero.
B. Receiving and Renaming Electronic Soil Analysis Reports

Soil analysis results that are received electronically can be imported directly into the Analyses sub-directory of NuMan Pro. If the default installation for NuMan Pro was used, the path will be C:\Program\UMCP\NuMan Pro\Analyses.

If the analysis was received by e-mail, use the Save Attachment function and change the file extension to reflect the laboratory that provided the analysis. Because labs use different data reporting formats, selecting the correct file extension is essential for proper conversion. Choose file extensions from the table below.

<table>
<thead>
<tr>
<th>Laboratory</th>
<th>File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>A &amp; L Eastern Agricultural Laboratories (Richmond VA only)</td>
<td>.eal</td>
</tr>
<tr>
<td>Agri-Analysis Inc.</td>
<td>.aai</td>
</tr>
<tr>
<td>Pennsylvania State University - Agricultural Analytical Services Laboratory</td>
<td>.psu</td>
</tr>
<tr>
<td>Brookside Laboratories Inc.</td>
<td>.bks</td>
</tr>
<tr>
<td>Spectrum Analytic Inc.</td>
<td>.sai</td>
</tr>
<tr>
<td>University of Delaware Soil Testing Program</td>
<td>.ude</td>
</tr>
<tr>
<td>University of Maryland Soil Testing Lab</td>
<td>.umd</td>
</tr>
<tr>
<td>Waters Agricultural Laboratories Inc.</td>
<td>.wal</td>
</tr>
</tbody>
</table>

To change the file extension:

- Navigate to the Analysis directory and locate the soil analysis file just saved.
- Highlight the file using the cursor.
- From the File menu (or right-click) select the Rename option. The name of the file will become editable.
• Use the Left and Right Arrow keys to position the cursor within the name and make the necessary changes. The file extension (last four characters) must be from the table above.

• When changing the file extension, one may also modify the file name to make it more easily recognizable (e.g. farmer_tractname_year).

Once familiar with the program, saving and renaming the file can be done in one easy step. However, it is a good practice to print out copies of the test results before making any changes.

On some computers, the **Hide File Extension for Known File Types** option might need to be changed. Within Windows, go to the **View** or **Tools** menu, select **Options** or **Folder Options**, then access the **View Tab** and uncheck the **Hide File Extension for Known File Types** option.

### C. Importing Soil Analysis Data

Importing soil analysis data electronically can save time and reduce input errors. However, all data should still be carefully checked for accuracy against the paper copy of the results received from the lab. Soil analysis data may be imported for a single field or for a group of fields.

1. **Importing Analysis Data for a Single Field**

   • Navigate to the field to receive the imported soil analysis.

   • Display the **Soil page**.

   • Select the lab that produced the report from the drop-down box. This selection tells NuMan Pro the report format to expect in the file.

   • Next click the **Import** button at the top right corner of the **Soil page**. A dialogue will open with the selected lab shown in the top left corner. If necessary, navigate to the directory where the electronic soil analysis file was saved.

   • Click to choose the desired file, then click **Open**.
- The **Select Import** dialogue will open the soil analysis report file and display a list of soil sample and lab analysis IDs.

- For labs that report soil analysis in more than one way, select the correct extraction method or units from the drop-down list on the far right. For labs with only one way, there will only be one option.

- Select the listing to be imported, click **OK**, and the soil analysis data for this listing will be deposited in the appropriate boxes on the **Soil** page. The appropriate calculations will be applied to convert the data to Maryland Fertility Index Values (FIVs) and the corresponding modified data will appear in the shaded boxes on the **Soil** page.
2. Importing Analysis Data for Multiple Fields at the Same Time

- Open the farmer file which is the target of the soil analysis data.
- From the Edit menu, select Import Soils Analysis.
• The **Soil Test Files** dialogue will appear. If necessary, navigate to the directory where the electronic soil analysis file was saved.

• Click on the desired file to select it, then click **Open**.

• The **Select Import** dialogue will open. On the **left** is a **Source List** of sample and lab analysis IDs in the soil analysis report file. On the **right** is a **Target List** of fields in the farmer's file.

• For labs that report soil analysis in more than one way, **select the correct extraction method or units** from the drop-down list on the far right. For labs with only one way, there will only be one option.
To pair data in a lab analysis with the correct field record:

- **Left-click** on a sample analysis in the Source List on the left.

- **Drag-and-drop** the report to the list on the right, placing it in position next to its target field listing. The analysis listings will not move, but will be copied. A listing that has been paired with a field will have a plus sign next to it in the Source List.

- Repeat this process until all analysis listings that should be paired with a field listing are paired.

- Linking report data to field records can also be done with keyboard commands. Use **Ctrl** to select an analysis item for linking. Use **Arrow** keys to navigate between and within both lists. The **Space Bar** will deposit an item in place. The **Shift** key will select an analysis item, in the Target List, for moving within the Target List.

There may be fields in the farmer’s file (list on the right) that do not have a soil analysis in this report. Those fields should have empty spaces next to their listing. There may also be report listings (list on the left) that do not correspond with any field. These remaining listings will be ignored and not imported.

Soil analysis listings may be paired with more than one field. Left-click drag-and-drop within the Target List to **copy** a listing from one field to another. Right-click drag-and-drop within the Target List to **move** a listing from one field to another. Right-click drag-and-drop does not function between the two lists.

**To remove an analysis listing from the Target List,** click on it to select the listing and then click **Unlink** at the top right corner of the dialogue.

When all the listings in the left side have been placed next to their counterparts in the right side, click **OK** and the report data will be deposited in the appropriate places in the **Soil** section for each paired field. The appropriate conversion will be applied to the data and the corresponding modified data will appear in the shaded boxes on the **Soil** page when each field is displayed.
VIII. Organic Materials

If organic materials (manure, sludge, etc.) are generated or utilized on the farm, information is needed about each individual material. NuMan Pro will summarize information from the available organic sources and make recommendations for field allocation. If no organic materials are utilized, skip this section, and go to the Field Tab.

A. Creating the Organics List

Click the Organics icon on the program Tool Bar to open the Organics List. If the list is blank, no organic sources have been entered for the current farm.

To add a new organic material to the Organics List, click the Add button on the right side of the Organics box. An empty Edit Organics Item box will open. Identifying information and analysis data can then be entered for an individual type of manure or sludge material.

The Edit Organics Item box is divided into Bookkeeping, Management, and Analysis sections.

The Bookkeeping section includes the waste analysis laboratory test number and test date; the County and Tract where the manure is generated, not necessarily the farm for which the plan
is being generated; the **Source** of the waste material which is a user defined name such as paddock or barn;

the **Class** of the waste material;

<table>
<thead>
<tr>
<th>Manure</th>
<th>Sludge</th>
<th>Miscellaneous</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dairy</strong></td>
<td></td>
<td><strong>Aquaculture Waste</strong></td>
</tr>
<tr>
<td><strong>Dairy</strong></td>
<td></td>
<td><strong>Aquaculture Effluent</strong></td>
</tr>
<tr>
<td>Beef</td>
<td></td>
<td><strong>Fish Emulsion</strong></td>
</tr>
<tr>
<td>Swine</td>
<td></td>
<td><strong>Corn Gluten</strong></td>
</tr>
<tr>
<td>Poultry.FR</td>
<td></td>
<td><strong>Compost. (if C/N&lt;25)</strong></td>
</tr>
<tr>
<td>Poultry.Int</td>
<td></td>
<td><strong>Feather Meal</strong></td>
</tr>
<tr>
<td>Horse</td>
<td></td>
<td><strong>Crab Meal</strong></td>
</tr>
<tr>
<td>Sheep</td>
<td></td>
<td><strong>Alfalfa Meal</strong></td>
</tr>
<tr>
<td>Goat</td>
<td></td>
<td><strong>Peanut Meal</strong></td>
</tr>
<tr>
<td>Llama</td>
<td></td>
<td><strong>Blood Meal</strong></td>
</tr>
<tr>
<td>Alpaca</td>
<td></td>
<td><strong>Veg Processing Residuals</strong></td>
</tr>
<tr>
<td>Buffalo</td>
<td><strong>Composted</strong></td>
<td><strong>Meat Processing Residuals</strong></td>
</tr>
<tr>
<td>Ostrich</td>
<td><strong>Lime stabilized</strong></td>
<td><strong>Waste Water Effluent</strong></td>
</tr>
<tr>
<td>Rabbit</td>
<td><strong>Anaerobically digested</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Unstabilized</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Aerobically digested</strong></td>
<td></td>
</tr>
</tbody>
</table>

If the material is not in one of the listed categories, select **Other** within **Miscellaneous**.

Use the additional drop-down list to declare waste characteristics as applicable.

<table>
<thead>
<tr>
<th>Solid</th>
<th>Liquid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid</td>
<td>w/o litter</td>
</tr>
<tr>
<td>Solid</td>
<td>w/litter</td>
</tr>
</tbody>
</table>

If solid is chosen, indicate whether it is with (w/) or without (w/o) litter. If liquid is chosen, the program automatically defaults to 835 lb/100 gal in the **Analysis** section; however, this can be changed if actual data differ.

The **Management** section has check boxes to indicate how the material will be managed. Selections made at this point will affect options available later in the program.

If the organic material is:

- produced elsewhere and brought onto the farm -- check **Imported**;
- produced on the farm where it is to be applied -- **do not** check **Imported**.
If the material is:

- produced on the farm, but there is no storage facility -- leave both boxes unchecked.

If there is a storage facility for the organic material, check Has Storage.

If Has Storage is clicked, two additional boxes will open.

- Type in the storage capacity of the storage facility in tons or thousands of gallons.

Type in the initial quantity of material already in storage in tons or thousands of gallons.

If the material is a manure and has had Alum applied to it, check Alum.
If the material is a sewage sludge and Biological Phosphorus Removal is applicable, check BPR.

The Analysis section displays boxes for entry of chemical analysis data. If the material is a sewage sludge, enter the appropriate values for PAN, Org, P₂O₅% and K₂O%.
If the material is a manure, enter the analysis values in the appropriate units as stated in the labels.

<table>
<thead>
<tr>
<th>Analysis</th>
<th>N%</th>
<th>Ca%</th>
<th>Mg%</th>
<th>Zn(ppm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NH4N%</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>P2O5%</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>K2O%</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

If the material is to be managed as a liquid waste, an appropriate liquid weight must be entered. If the material is to be managed as a solid, the liquid weight box will be disabled, but its moisture content may be entered.

After all data have been entered, click **Add to organics list** to enter the organic material into the Organics List (sometimes referred to as the Organics Master List). Clicking **Cancel** will cause all data in the current **Edit Organics Item** to be discarded.

To remove a material from the Organics List, highlight it and click **Remove**. Clicking **Remove** will erase all data for that listing throughout the current farmer’s file.
To edit a material in the Organics List, highlight the item, click Edit, and the Edit Organics Item dialogue will open for editing. When editing is finished, click Add to organics list to save the information in the current working memory, close the dialogue box, and return to the Organics List. Click Cancel to close the dialogue box, discard the edited information, and restore the listing to its pre-edited condition if edits are not to be saved.

After a new organic item is entered or any existing organic is edited, the new information will appear on the Organics List. However, click OK in the Organics List dialogue to write the information to the working memory of the program and synchronize the edited organic information throughout the file. Since the basis of all nutrient recommendations for a particular organic material depends on the properties of the material, editing the properties can cause changes in all recommendations regarding use of the edited material.

Clicking Cancel will close the Organics List dialogue and discard any changes. Cancel may be used when data within the Organics List are examined, but do not want to save any changes.

**Special Note:** If the total quantity of a manure will be exported, a ‘null’ or empty organic item must be created in order to print the manure generation information. To make a "null" organic item, select the class, group and status of the material. Enter the words "for printing" into the Source text box to identify this item as exclusively intended for printing purposes. No additional information is required in the Edit Organics Item dialogue to create the null item.

### B. Manure Generation

The Manure Generation portion of the program is used to calculate the quantity of manure produced on the farm and the quantity available for use from on-site sources. A manure sample may be selected from the Organics List and linked to the manure generation information. The manure production rate will then be displayed as a line graph on the NuMan Pro waste balance page. In this way manure applications may be balanced according to the estimated volume of manure on hand relative to the capacity of the storage facility.

Click the Manure Generation icon on the Tool Bar (or select from the Edit menu, or use Ctrl+d) to open the Manure Generation Spreadsheet. Any manure generation spreadsheets previously entered or linked to analysis information in the Organics List will be displayed.
To create a new manure generation listing, click Add. Select the Animal Group from the drop-down box. Free Range (F.R.) Poultry includes any poultry species raised under traditional (not integrated) conditions.

For Accounting Method, the drop-down list box displays three selections: Pub. man. gen., Manual, or Farmer’s Record.

- **Pub. man. gen.** (short for “published manure generation”) provides access to the Manure Quantity Estimation Spreadsheets. For integrated poultry, it allows manure estimation based on number and type of birds per flock. For animal groups other than integrated poultry, it uses published estimates of daily manure generation to approximate total manure generation for a selected time period.

- **Manual** estimates manure quantity for a selected period of time when a farmer knows his historical average daily manure generation.
Farmer’s Record is used when the farmer has manure quantity and removal records from the previous year or when manure production has been estimated with the Excel spreadsheets on the ANMP website. A calendar grid is provided for entering amounts of manure into specific time slots.

In the center of the dialogue is a text box for entering a Reference Title, that is, a name that uniquely identifies this particular manure source and is recognizable to the user.

At the bottom left is a box labeled Solid Only which is checked by default. If the manure is managed as a liquid or is separated into both liquid and solid, uncheck the box.

When all data have been completed, click OK to continue the spreadsheet creation process. The next stage will depend upon the accounting method selected previously. To discard all entered data and terminate the manure entry process, click Cancel.
1. Published Manure Generation Estimates for Integrated Poultry

From the Add Manure Spreadsheet, select **Int. Pltry. Prod.** as the animal group and **Pub. Man. Gen.** as the accounting method, the following screen will appear.

The top grid presents a twelve month calendar that allows the user to indicate when cakeouts and total cleanouts occur, once the information on bird type, number of birds per flock, and number of flocks since last total cleanout, have been entered (white colored data entry boxes) in the Poultry Manure Production column(s) below. The litter and cake production estimates (blue cells in Poultry Manure Production column(s)) will then be calculated automatically.

At the middle right of the page is a box to optionally indicate groups of houses (up to 3 groups) that are on different cleanout schedules. The default is 1 (i.e. all houses on the same cleanout schedule), however if additional groups are needed, use the small arrows to select the **number of groups.**
Below the sub-group number box, along the lower right side of the dialogue, are the Control Buttons for this page.

Clear will clear all input data on the page and display default values. OK will accept any changes and then close the dialogue. Cancel will close the dialogue and discard any changes. Revert will not close the dialogue, but will return all values to a pre-edited state.

Estimating Poultry Manure Generation

With the number of groups established, select the Bird type from the drop down list at the top of the column(s) in the poultry manure production section of the page.

Enter the Number of birds per flock in the next cell of the column.

<table>
<thead>
<tr>
<th>Poultry Manure Production</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bird type</strong></td>
<td>broiler</td>
<td></td>
</tr>
<tr>
<td>Number of birds per flock</td>
<td>25000</td>
<td>50000</td>
</tr>
<tr>
<td>Number of flocks per year</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Litter+cake, tons/1000 birds</td>
<td>1.10</td>
<td>1.10</td>
</tr>
<tr>
<td>Cake, tons/1000 birds</td>
<td>0.20</td>
<td>0.20</td>
</tr>
<tr>
<td>Litter+cake, tons/year</td>
<td>165.0</td>
<td>330.0</td>
</tr>
<tr>
<td>Total cake, tons/year</td>
<td>30.0</td>
<td>60.0</td>
</tr>
<tr>
<td><strong>Total Cleanout</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Quan/flocks since last cleanout</strong></td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Cake removed in this cleanout</td>
<td>5.0</td>
<td>10.0</td>
</tr>
</tbody>
</table>

The next step is to specify the number of cakeouts that will occur during this year. Click on the top cell (numbered 1, 2 or 3) of a Poultry Manure Production column,
Then go to the calendar grid to indicate when cakeouts will be removed. Click in the **Cake schd** row in the appropriate half month period for each cakeout. Colored dashes will appear in these cells (green for the first group, red and blue for groups 2 and 3, if needed). The dash colors will correspond to the column colors for the groups in the Poultry manure production columns. The cakeout indicator dashes may be removed by clicking on them a second time.

For each cakeout marker placed, the amount of cake removed as a result of that flock will appear in the **T/event** (Tons per event) cell below the marker, and the total removed for the year will be displayed in the **Total** column, on the far right of the grid. The number of flocks per year for selected column in the Poultry Manure Production table will automatically match the number of cakeouts indicated.

If a **Total cleanout** will occur during this year, also fill in the box for the **Quan./ flocks since last cleanout** (midway down the column) with the number of flocks that have been in the house since the last total cleanout.

Click on the colored **Total Cleanout** cell in the column (numbered 1, 2 or 3 for a group),

then indicate when the total cleanout will be removed by clicking in the **Clnout schd** row, in the half month period when it will occur (A cakeout must also have been indicated in the same half month period, to include the cake for that final flock).

A colored dash will appear in this cell (green for the first group, red and blue for groups 2 and 3, if needed). The dash colors will correspond to the column colors for the groups in the Poultry manure production columns. The total cleanout indicator dashes may be removed by clicking
on them a second time. For the total cleanout marker placed, the amount of litter + cake removed during that half month period will appear in the T/event (Tons per event) cell below the marker. The right most column of the grid will display the total litter + cake removed for the year.

At the bottom of the column(s) is a drop down list of all poultry manure analyses in the Organics List.

<table>
<thead>
<tr>
<th>Number of flocks per year</th>
<th>6</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Litter+cake, tons/1000 birds</td>
<td>1.10</td>
<td>1.10</td>
</tr>
<tr>
<td>Cake, tons/1000 birds</td>
<td>0.20</td>
<td>0.20</td>
</tr>
<tr>
<td>Litter+cake, tons/year</td>
<td>165.0</td>
<td>330.0</td>
</tr>
<tr>
<td>Total cake, tons/year</td>
<td>30.0</td>
<td>60.0</td>
</tr>
<tr>
<td><strong>Total Cleanout</strong></td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Quan/flocks since last cleanout</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Cake removed in this cleanout</td>
<td>5.0</td>
<td>10.0</td>
</tr>
<tr>
<td>Litter removed in cleanout, tons</td>
<td>270.0</td>
<td>540.0</td>
</tr>
<tr>
<td>Litter+cake removed this year</td>
<td>300.0</td>
<td>600.0</td>
</tr>
<tr>
<td><strong>Link to manure type</strong></td>
<td>Poultry Transi</td>
<td></td>
</tr>
</tbody>
</table>

Click on the arrow on the right side of the “Link to manure type” row to **link this poultry manure generation quantity to its manure analysis**. This enables use of this poultry manure quantity on the manure balance page, and enables printing of the poultry manure generation spreadsheet.

Each manure sample in the Organics List may be linked to only one manure quantity estimation spreadsheet. If the manure analysis selected was previously linked to another manure generation spreadsheet, the new linkage will replace the previously indicated linkage. The manure analysis linked to this spreadsheet may be updated when a new manure analysis is obtained.

Once the user has entered all appropriate data and placed time markers, click the **OK** button. The dialogue will close and return the user to the Spreadsheet Master List, then click the **OK** button on this page to return to the main NuMan Pro screen. For this generation spreadsheet to be saved permanently, you must then save the NuMan Pro file.
2. **Published Manure Generation Estimates for All Other Animals**

The Pub. man gen. dialogue box for all other animals allows the year to be divided into two parts to account for seasonal differences in confinement and grazing time.

In the top left corner are drop down boxes for setting the starting and ending dates for the first manure generation period. As the dates are set, the total number of days in the period will appear in the text box immediately to the right.

When beginning and ending dates for the first time period have been established, reciprocal dates for the remaining time period, equaling one calendar year, are set by default into the dialogue for the second time period. This second time period dialogue may be viewed by clicking the Page 2 button at the bottom right of the present dialogue.
The second time period may be reduced, so that the combined time represented by both is less than one year, but it may not be increased so that the total time under consideration is more than one year.

Click the button to return to the first time period.

Just above center, at the right side of the dialogue, is a number box to indicate how many animal sub-groups contribute to this type of manure. Use the small arrows, above the number box, to display the correct number. The number of spreadsheet columns will change to reflect the number of sub-groups.

Select the specific animal sub-group from the drop down list at the top of each column. Fill out the livestock information for each sub-group. The editable rows in each column will vary depending on whether or not solid only was left checked in the initial setup of this spreadsheet. For example, the Liquid manure fraction row appears only when the solid only box is unchecked. Enter a number between 0 and 1 in this box to indicate what proportion of the manure from this animal group goes into the liquid manure storage structure.
Use the scroll bar on the right side of the spreadsheet to move down and access additional information requirements.

<table>
<thead>
<tr>
<th>Bedding Type</th>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ls. straw</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ls. woody</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ls. soil</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ls. sand</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ls. nonlign</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ls. alfalfa</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bl. straw</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bl. woody</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bl. lignin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bl. nonlign</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ch. straw</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ch. wisteria</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ch. nonlign</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If applicable, select the specific type of bedding from the drop down list in the lower center section of each column. Abbreviations in the list are Ls = Loose, Bl = Baled, and Ch = Chopped.

Enter the values for each sub-group in the remaining white boxes. If the volume of bedding is entered, the weight of bedding will be calculated and will be displayed in the appropriate row. Conversely, if the weight of bedding is entered, the volume of bedding will be calculated and displayed.
Below this, the amount of Uncollected manure and Collected solid manure will be shown for each animal group. For the collected solid waste click on the arrow on the right side of the “Link to Solid Manure Type” row, to **link this solid manure quantity to its manure analysis**. This enables use of the solid manure quantity on the manure balance page, and enables printing of the manure generation spreadsheet.

Note that only manure samples in the Organics List from the same animal group and consistency will be available. Each manure sample in the Organics List may be linked to only one spreadsheet linked manure entry. If a manure sample is chosen that has a previously selected linkage, the new linkage will replace the previously indicated linkage.

When applicable, the collected liquid waste will be shown next.

If the manure is managed as a liquid, the additional wash water and rainfall that enters the liquid storage structure must also be considered.
Enter wash water (gallons per day), inches of rainfall during the generation period and the square footage of the runoff collection area to calculate total runoff volumes. The (24hr rain in 25yr) row will display a list of the twenty-three counties in Maryland and the 24hr rain in 25 years rainfall quantity when the cursor is positioned in the row. This listing is only for information purposes and it is the user's option to directly enter the appropriate value into the cell.

Enter the actual square footage of the storage structure. This area is accounted separately from the rest of the runoff area.

For the collected liquid waste, click on the arrow on the right side of the “Link to Liquid Manure Type” row to link this liquid manure quantity to its manure analysis. This enables use of the liquid manure quantity on the manure balance page, and enables printing of the manure generation spreadsheet.
Note that only manure samples in the Organics List from the same animal group and consistency will be available. Each manure sample in the Organics List may be linked to only one spreadsheet linked manure entry. If a manure sample is chosen that has a previously selected linkage, the new linkage will replace the previously indicated linkage.

Below the sub-group number box, along the lower right side of the dialogue, are a set of Control Buttons. Clear will remove all input data and display default values. OK will accept any input values and then close the dialogue. Cancel will close the dialogue and discard all changes. Revert will not close the dialogue, but will return all edited values to a pre-edited state.

To reduce some data entry, the dialogue for the second time period will contain the same quantity and type of sub-groups selected in the first period. Procedures described above to enter data in the first period dialogue are used in the second period dialogue. When data has been entered into all columns for both time periods, click the OK button. The dialogue will close and the user will be returned to the Manure Generation Spreadsheets Master List.

3. Manual Method

In the top left corner of the Manual Manure Generation dialogue are two sets of three drop-down list boxes. NuMan Pro will allow the user to divide the year into two parts to account for seasonal differences in manure production. Each set of boxes contains entries for Month, Day and Year, respectively.

<table>
<thead>
<tr>
<th>Starting date</th>
<th>Ending Date</th>
<th>Total days</th>
<th>Production rate, lb or gal per day</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nov 1 2004</td>
<td>Feb 28 2005</td>
<td>120</td>
<td>6000</td>
</tr>
</tbody>
</table>

These controls are used to set the beginning and ending dates for the first manure generation period. Open each list and scroll if necessary to display and then select the correct chronological listing. As the dates are set, the total number of days in the period will appear in the text box immediately to the right.

When beginning and ending dates for the first time period have been established, reciprocal dates for the remaining time period, equaling one calendar year, are set by default into the dialogue for the second time period.
This second time period dialogue may be viewed by clicking the **Page 2** button at the bottom right of the present dialogue. The time period in the second dialogue may be reduced, so that the combined time represented by both dialogues is less than one year, but it may not be increased so that the total time under consideration is beyond the default maximum of one year (i.e. the combined time periods represented by both dialogues cannot exceed one year).

Click the **Page 1** button to return to the first time period.

Enter the daily production rate into the spaces provided on both pages as appropriate.

Once all information is entered, return to **Page 1**. Open the drop-down list near the middle of the dialogue and select the desired manure sample from the Organics Master List that should be linked to the data from this instance of Manual Method.

Once all information has been entered, open the **Link to an Organic Item** list and select a manure sample from the Organic Master List for linking to the current spreadsheet.

Only manure samples from the same animal group will be available in this list. Each sample in the Organics Master List is limited to one spreadsheet link. If there is a previously existing link to a manure sample in the Organics Master List, establishing a new link will replace the previous link. Once information has been entered, click the **OK** button. The dialogue window will close and the user will be returned to the Spreadsheet Master List.

### 4. Farmer’s Record Method

The Farmer’s Record Method is used when there are records of when and how much manure has typically been removed at specific times of the year. It may also be used when the amount of manure produced has been estimated using the Excel spreadsheets on the ANMP website. It may be used in combination with the Manure Balance feature.

Clicking the cell within each half month time period will place a marker in that cell and indicate times that the facility will be cleaned out. Once a marker is placed, the cell below the marker is editable. Enter the quantity of manure expected removed at each date into the cell under the appropriate marker. Once all markers and all quantities have been entered, open the drop-down list near the center of the page and select the desired manure sample from the Organics Master List for linking.
Once all information has been entered, open the Link to an Organic Item list and select a manure sample from the Organic Master List for linking to the current spreadsheet.

Only manure samples from the same animal group will be available in this list. Each sample in the Organics Master List is limited to one spreadsheet link. If there is a previously existing link to a manure sample in the Organics Master List, establishing a new link will replace the previous link. Once information has been entered, click the OK button. The dialogue window will close and the user will be returned to the Spreadsheet Master List.

**C. Organic Balance**

The Organic Balance feature combines a view of the amount of collected manure generated or imported by an operation over a 1 year period, with a view of the fields likely to receive this manure. This assists in determining whether there is enough land available to utilize the amount of organic material or whether some will have to be exported from the operation.

To use this feature with organic material generated by the operation, you must first enter an organics analysis, apply that analysis to the fields where that organic material will be applied, and complete a manure generation spreadsheet linked to the same organics analysis. For imported materials, a manure generation spreadsheet is not necessary.

When this information has been entered, click on the balance icon:

At the upper left corner of the Organic Balance page, click to select the organic material of interest from the drop down Organics Master List.
The display of this page will vary slightly, depending on whether the selected organic material was designated as having storage, or as being imported when its organic analysis was entered.

To the right of the drop down list is a line graph that displays a visual representation of the production and/or application of the selected material over a twelve month period (starting in October and ending in September). For an organic material produced on farm, this display presents a visual comparison of the cumulative application of the organic material in consideration of the current available amount.

If the organic material is managed within a storage facility, the graph will be tailored to indicate the accumulated amounts in the storage (blue line) in relation to the relative capacity of the facility. Applications of the organic material will reduce the amount indicated in storage. If the blue line goes above the top red line, this indicates that the storage capacity has been exceeded. If the blue line goes below the lower red line, this indicates that the storage facility has been emptied.

If the manure is produced on-farm, but there is no defined storage facility, the graph will indicate 2 lines, the annual generation of the organic material is indicated by the brown line, and the field applications are indicated by the blue line. When balancing generation vs. applications, the 2 lines will begin to overlap.
If the material is imported, the graph will indicate the cumulative annual application for all fields containing this material as the primary nutrient source. The total will indicate how much manure can be imported under the given scenario.

![Graph showing annual application of manure](image)

Directly beneath the line graph will be a two row grid. If the listed material is produced on-farm and the farm has a storage facility, the top row will indicate the quantity available at the end of each month.

<table>
<thead>
<tr>
<th>Month</th>
<th>Quantity Available (ton)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>75</td>
</tr>
<tr>
<td>Feb</td>
<td>144</td>
</tr>
<tr>
<td>Mar</td>
<td>212 +278</td>
</tr>
<tr>
<td>Apr</td>
<td>346 +346</td>
</tr>
<tr>
<td>May</td>
<td>214 -19</td>
</tr>
<tr>
<td>June</td>
<td>200 300 500</td>
</tr>
</tbody>
</table>

If the amount of organic material within storage exceeds the storage facilities' capacity, the quantity will be preceded by a plus sign and the text will be **RED** in color. A small square as a graphic indicator will also appear above the upper limit line on the graph. If the total quantity of available organic material exceeds the storage facility in the middle of the month, but the amount does not exceed storage at the end of the month, the text of the quantity displayed will be in black in color, but the small square will still appear on the graph to indicate an excess condition existed during the time interval. If a deficit of organic material occurs within the facility, the value will be preceded by a minus sign and the text will also be **RED** in color.

The second row of the grid allows input of the amount of organic material to be exported and, therefore, not applied to fields in this operation. The total amount of exported material is shown in the cell at the far right of this row.

If the listed material is produced on-farm but the farm has no storage facility, the top row will be a shaded grey color and display the difference between the estimated total production and the accumulated application or export of the material. The second row functions the same as it does for a stored organic material.

<table>
<thead>
<tr>
<th>Available</th>
<th>Exported</th>
</tr>
</thead>
<tbody>
<tr>
<td>142</td>
<td>500</td>
</tr>
<tr>
<td>268</td>
<td>500</td>
</tr>
<tr>
<td>398</td>
<td>500</td>
</tr>
<tr>
<td>28</td>
<td></td>
</tr>
<tr>
<td>146</td>
<td></td>
</tr>
<tr>
<td>276</td>
<td></td>
</tr>
<tr>
<td>402</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td></td>
</tr>
<tr>
<td>207</td>
<td></td>
</tr>
<tr>
<td>362</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>168</td>
<td></td>
</tr>
</tbody>
</table>

If the material selected was indicated as being imported when entering the organics analysis, this 2 row grid will not be displayed.
The lower portion of the page is the **Application Timing Grid**. It displays a listing of the fields that were indicated to receive the selected organic material as their primary nutrient source on the scenario page for this field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Acres</th>
<th>App</th>
<th>0</th>
<th>64</th>
<th>64</th>
<th>0</th>
<th>96</th>
<th>112</th>
<th>0</th>
<th>96</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>431</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>North</td>
<td>22.0</td>
<td>1</td>
<td></td>
<td></td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>112</td>
</tr>
<tr>
<td>3</td>
<td>East</td>
<td>22.0</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>160</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>22.0</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>160</td>
</tr>
</tbody>
</table>

The left column of this grid displays the field's order number as entered into the NuManPro program. The next column displays the name of the field. The third column displays the number of acres in the field. The fourth column displays the number of applications, or splits, recommended for the field (1, 2 or 3). The remaining major portion of the grid is used to declare the timing of the organic material application. This grid is blank the first time it is opened for an organic material. The timing of each application is indicated by clicking in the appropriate box for the month applied: early (the 1st through the 15th of the month); or late (the 16th through the end of the month). A blue X mark will be displayed in the appropriate box. At the top of the grid, above each month, is the total quantity of the selected material applied (the amount/acre recommended x the acres in the field totaled for all fields indicating applications that month). In each row at the right end of the grid, when all marks are placed, is the total quantity of the selected material applied to that field. In the top right corner of the grid, is the total quantity of all indicated applications of the selected material, for the year.

**Note:** If a field listed in the grid has an organic package (more than one type/source of organic material) applied to the field, the other components of the package are represented by a slightly shaded row adjacent to the row pertaining to the selected organic material. Timing marks in a shaded row may not be altered from this view. The other organic material component of the package must be selected in the list at the top left of the page to declare and/or change the timing marks for those materials.

47
IX. History

The History page contains a grid where previous years of organic nutrient applications and residual nitrogen information are displayed for the current field. The following figure shows a blank History page.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min Rate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NH₄ (total)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NH₄ %</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avl org NH₄ %</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>L. Weight</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item #</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following figure shows a field where poultry litter was applied in 2008 and 2009 and lime stabilized sewage sludge was applied in 2005.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Pltr +L</td>
<td>Pltr +L</td>
<td></td>
<td></td>
<td>Lime St&amp;A</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min Rate</td>
<td>0.15</td>
<td>0.08</td>
<td></td>
<td></td>
<td>0.30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td>3.0</td>
<td>3.0</td>
<td></td>
<td></td>
<td>3.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td>tons/A</td>
<td>tons/A</td>
<td></td>
<td></td>
<td>tons/A</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NH₄ (total)</td>
<td>3.0000</td>
<td>3.0000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NH₄ %</td>
<td>1.0000</td>
<td>1.0000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avl org NH₄ %</td>
<td>0.3000</td>
<td>0.1600</td>
<td></td>
<td></td>
<td>2.8000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>L. Weight</td>
<td>0.0</td>
<td>0.0</td>
<td></td>
<td></td>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item #</td>
<td>1 (1)</td>
<td>1 (2)</td>
<td>▲</td>
<td>▲</td>
<td>1 (1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Column labels begin one year prior to the plan year shown on the Scenario page. For manure, only two previous years of accounting for residual nitrogen are required. For sludge, nine years of accounting for residual nitrogen are required. All nine previous years are shown in the grid, regardless of the type of material.

Row labels identify the type of data contained in each row. If multiple manures were applied in a single year, the data for each manure may be viewed by clicking on the arrows in the Item # row. Any credits will be displayed on the upper left side of the Recommendations page.
The organic item number is displayed in the bottom row. If multiple organics are utilized, each item can be viewed separately by selecting from the arrow box on the bottom row.

A. Modifying History Data

As the planning year on the Scenarios page is advanced, a new blank column is created on the History page to input previous nutrient management information. Previously entered history information from the prior planning year is shifted accordingly to retain chronological order. Complete history data is required if the nutrient management recommendation for the correct year is to accurately account for nutrient inputs from previous plan years.

To enter new data and/or to edit existing data, double-click on the cell at the top of the desired column (or click in the first cell of a column and press Enter). A dialogue with text boxes for that column will appear to allow data entry.

To begin entering a manure application history, click on the "Add New" button. Select the organic material type utilized for land application in the year of the history record from the drop-down list box. The default yearly nitrogen mineralization rate for the material will be automatically entered (this value may only be edited when Other is the type selected). Enter the amount of organic material applied and select the unit of application. Enter organic analysis information in each of the remaining boxes as applicable.

After entering the data for the first application, click on the "Add New" button again to enter data for up to 2 more applications. View the data for multiple entries by clicking on the arrows at the bottom of the data entry window. Click OK to deposit the information into the History page. Clicking Cancel aborts the data entry. Clicking Clear removes all values from the present dialogue. Any new and/or edited information will not be saved for future program use until the file is saved.
X. Scenarios

The Scenarios page is used to identify management practices for individual fields such as type and quantity of organic material to be applied, crops to be planted, yield goal, tillage method and legume credit. Information about manure and other organic materials is entered in the Organics Grid at the top of the page and crop information in the Crop Grid below. Fields receiving only commercial fertilizer, not manure or other organic materials, do not need the organics section.

Begin with the crop portion, which is in the middle of the page.

A. Crop Portion of Scenarios Page

To complete the crop grid:

- Click the Add button to the right of the Crop Grid to display the Crop dialogue with a listing of available crops.
- Scroll to and highlight the name of the desired crop.
- Click Add to insert the selected crop into the Crop Grid on the Scenarios page.
The **Crop list may be sorted** by ID Number, Category, or Name. Click on the column title at top to sort by that property. Click on ID to sort the crops in ascending order (1-323) with the most common crops listed first. Click again to sort in reverse order. Click on Category to sort by type of crop such as grain, oil, forage, vegetable, fruit, sod, trees, etc. Click on Name to sort alphabetically.

Common **double crop** combinations (wheat/soybeans) have a single crop code. Other **multiple crop** combinations (peas followed by sweet corn) may be selected by the following steps. **Left-click on first crop, hold down control and left-click** on additional crop(s). Click **Add** when all crops have been selected.

If a farmer is undecided about which crops will be planted in a given year, multiple crops may be selected, but one must be marked as the **Primary** recommendation scenario (the crop most likely to be grown). The primary preference is indicated by a colored cell in the left header of the listing. By default, the first crop selected is marked as the primary preference. To change the primary preference designation, click in the cell to the left of the desired crop. Only one crop may be designated as the primary preference.
When all crops have been added, enter the **yield goal** in the **units indicated** in the text box to the right of the crop name and press the **Tab** key to complete the data entry.

**B. Organic Portion of Scenarios Page**

The **Organics Grid** occupies the upper portion of the page and displays information on organic materials chosen for field application. The column labels within the grid are Reference Number (**Ref**), Source (**Type**), Basis for Recommendation (**Rec Base**), Application Rate (**Amount** and **Units**), Mineralization Rate (**MinR**) and the Percentage (%) of crop fertility requirements for nitrogen, phosphorus or potassium the organic material will supply.

To select an organic material for field application:

- **Click Apply** in the **Organics Grid** at right. A box will open showing a listing of all manures and sludges available to this farmer for land application.

- **Highlight** the organic material to be applied.

- **Click OK** to enter the organic material into the Organics Grid with a corresponding reference number and source information.

- **Click on the small arrow within the **Rec Base** box to select the basis for the recommendation (**Preset Rate**, **Nitrogen**, **Phosphorus**, or **Potassium**).

- **If you select Preset, enter the amount.** Right-click on the cell displaying the units if the units need to be changed. If nitrogen-, phosphorus- or potassium-based plans are chosen, the application amount information for that material is ignored. If the Pre-set-based plan is selected, the value entered into the % text box is ignored.

- **If more than one** individual organic material is entered into the grid, one organic material must be marked as the **Primary** recommendation scenario (i.e. the organic material most likely to be applied). The primary preference is indicated by a colored cell in the left header of the listing. By default, the first material applied is marked as the primary preference. To change the primary preference designation, click in the cell to the left of the desired listing or press the space bar while the cursor focus is on the cell containing the material type. Only one organic material may be designated as the primary preference.
(See the help section on Split Manure Applications for more information on using the Organics Grid.)

To add additional organic materials to the Organics Grid or additional crops to the Crop Grid, repeat the above-stated procedure for that grid.

To remove an item from either grid, place the cursor on the source box for the Organics grid or the crop name box for the Crops grid, to highlight the item to be removed, then click the Remove button to the right of that grid.

The combination of primary organic material and primary crop is the Primary Scenario for the current field (i.e. the most likely combination of organic material to be applied and crop to be grown) and will be listed at the top of the Scenarios list box on this field's Recommendations page.

### C. Bottom Portion of Scenarios Page

<table>
<thead>
<tr>
<th>Select Year</th>
<th>Tillage</th>
<th>Oxides %</th>
<th>Leg.Credit Lbs/A</th>
<th>PSI calculation may be required for this field</th>
</tr>
</thead>
<tbody>
<tr>
<td>2009</td>
<td></td>
<td>50</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Select the year** the crop(s) will be grown.
- **Select type of tillage** from the drop-down box. Choose conventional tillage if less than 30% of the soil surface is covered by crop residue; conservation tillage if between 30 and 70% covered; and no-tillage if more than 70% covered. The tillage information will need to be updated when importing older files.
- **Oxides %** (for lime) defaults to 50%; however, the value can be edited if a lime material with a different % oxides will be applied.
- **Insert legume credit**, the pounds of nitrogen per acre supplied by a previous legume crop and which will become available to the current crop.
- The two check boxes for **Trns P Rem** and **Reg P Rem** are explained in the section on Phosphorus Removal Plans. NuMan Pro users who work with a large number of fields should also review Special Scenario Functions.
- **Click History** in lower left to save the primary manure scenario for the current year to history just before updating the crop year for next year’s plan. For example, if updating
a 2009 plan for 2010, click on the history button while the ‘Year’ on the scenario page still reads 2009. Next, edit the year to read 2010. The 2009 application will now appear on the History page.

- **Revert** will discard all edits on the Scenarios page. As long as no other field has been displayed since the edits were made, or the file has not been saved, the information on this page will return to a pre-edited condition.

### D. Split Manure Applications

Split Manure Applications occur when manure is applied at different times during the crop’s growing cycle or when more than one manure is applied to the same field to jointly accommodate the crop’s nutrient requirements. Certain crops, such as small grains and some grasses, require split manure applications for agronomic and environmental reasons. NuMan Pro will automatically recommend single manure split-applications for those crops. These instructions apply to crops where split applications are desired, but not required. Split applications may be manually selected by one of two methods.

**Method A** – Add the same manure more than once with the same or different pre-set rates:

- Click **Apply** in the Organics Grid on the Scenarios page.
- **Highlight** the material in the Organics list, then click **Apply**.
- **Click Split** button next to the Organics Grid to display the Organics List.
- Select the same, or another, material listing and click **Apply**. This listing will now appear in the Organics Grid beneath the first selection.

**Method B** – Add more than one type of manure to the same crop:

- Click the **Apply** button next to the Organics Grid on the Scenarios page to display the Organics List.
- Hold the **Ctrl** key while highlighting up to three material listings with the mouse and then click the **OK** button. The highlighted listings will appear in the Organics Grid.
Using either method, the listings will be linked into an Organics Package and separated from any other listings by a barrier line. Organics Packages are limited to a maximum of three organic material listings.

Only the first listing in a package will have a recommendation basis selection text box and this text box will govern the basis for the entire package. Other information for each listing in the package must be completed separately.

If a **Pre-set Rate** has been selected, the percentage (%) column will not be used. If a nitrogen-, phosphorus- or potassium-based plan is selected, the amount column will not be used. By default, the first listing's percentage text box in an Organics Package will show a value of 100 and the remaining listings in the package will show a percentage value of zero (0).

- If there are 2 listings in the Organic Package, allocate the relative proportions of organic material in the Organics Package by placing the cursor in the percent text box for the first listing and enter a percentage amount less than 100 (e.g. 40). The remainder (i.e. 60) will be automatically deposited into the second listing's percentage text box.

- If there are three listings in the Organics Package, place the cursor focus in the percentage text box of the first and second listings and enter a percentage amount for each. The remainder will be deposited into the third listing's percent cell.

The **Organics Grid** will not permit an Organics Package to be allocated at more than 100 percent.

Make sure the mineralization rate for all listings is correct and edit any value as needed.

### E. Phosphorus Removal Plans

Check either the **Trns P Rem** (Transport Manure Phosphorus Removal) or **Reg P Rem** (Regular Phosphorus Removal) indicator boxes at the bottom of the **Scenarios** page if a phosphorus removal plan is desired for a particular field. When either indicator box is checked, standard procedures for calculating nutrient management recommendations for this field will be disabled. The marker at the left of the Crop Grid and the data status indicator on the **Scenarios** page tab will change color to indicate planning for this field represents a special case scenario. The user should then follow the instructions for **Transport Manure P Removal Plans** or **Regular P Removal Plans** to implement the appropriate plan for this field.
1. Regular P Removal Plans

Use the following procedure to implement a Regular P Removal Plan (Reg P Rem) for a field.

- On the Scenarios page, check the box for Reg P Rem.

- Update the year, displayed in the box at the bottom left corner of the page, to reflect the cropping year of the plan. Once the Reg P Rem box is checked, the year cannot be changed.

- A Regular P Removal Plan is limited to crop removal of the applied phosphorus. If manure is utilized as a phosphorus nutrient source, only a single manure application may be applied. If commercial fertilizer is utilized to supply phosphorus, do not associate a manure with the field. If a manure is being used, choose the appropriate manure to be applied to this field and check/edit the mineralization rate to ensure that the default value is correct.

- Choose a crop and enter its yield goal. Click the Reg P Rem check box near the middle bottom of the page to mark this field as a special case scenario. The data status indicator at the top of the page and the marker next to the crop will change color to flag.
this field as a special case scenario. Additional columns will become visible in the Crops Grid to display phosphorus utilization by the crop.

- Double-click on the cell displaying the crop name to change the listing to a different crop and/or click on the cell displaying the yield goal to enter or change that value. No other cells in this grid are editable.

- To account for phosphorus removed with straw, right-click the crop name for small grains (i.e. barley, oats, rye and wheat). The "phosphorus pounds per unit" cell in the grid will turn green to indicate that straw is being removed. Note that double crops are not eligible for use in regular phosphorus removal plans.

To view the fertility recommendations, go to the Recommendations tab. The crop will be listed in the upper right hand box of the page along with a reference number of the organic material chosen. The nutrient management recommendation displayed in the Recommendation Grid will be limited by the phosphorus uptake for the selected crop. The default value of the days to soil incorporation (#) for the manure are set to the shortest available time and should be edited to reflect planned field management operations.
2. **Transport Manure P Removal Plans**

Use the following procedure to implement a Transport Manure P Removal Plan (Trns P Rem) for a field.

- On the **Scenarios** page, **check** the box for **Trns P Rem** to mark this field as a special case scenario.

- **Update the year** in the box at bottom left to reflect the year of the first crop in the Transport Manure P Removal Plan. Year selection initiates the planning process for calculating phosphorus credits as applicable for the second year of the plan.

- Apply a single manure to this field and input the application rate. (Transport P Removal Plans are automatically changed to a Pre-set Rate with a single manure.) Check/edit the nitrogen mineralization rate to insure that the default value is correct. Values in the manure % distribution column are ignored in Transport P Removal Plans.

- Add a crop and enter the yield goal. A double crop will be automatically separated since the amount of phosphorus utilized by each individual crop must be considered.

The marker next to the crop and organic material will change color to flag this field as a special case scenario. Additional columns will become visible in the **Crop Grid** to display phosphorus utilization by the crop(s).
Under the **P-Balance** header to the far right of the page between the **Organics** and **Crops** controls are two boxes. One box displays the amount of phosphate per acre provided by the application of the manure at the specified rate. This value can be adjusted by increasing or decreasing the rate of application. The uptake box displays the amount of phosphate that can be removed by the crop(s) listed in the **Crop Grid** at the specified yield goal(s).

- Once the **Trns P Rem** box is checked, the cropping year may not be manually changed as the year will automatically change, according to the crop highlighted, taking into account single and/or double crops.

- To enter a second crop, click the Crop’s **Add** button. The **Crops List** will appear.

<table>
<thead>
<tr>
<th>ID</th>
<th>Category</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Grain</td>
<td>corn grain, conventional tillage</td>
</tr>
<tr>
<td>2</td>
<td>Grain</td>
<td>corn grain, alternate no-till/conventional till</td>
</tr>
<tr>
<td>3</td>
<td>Grain</td>
<td>corn grain, continuous no-till</td>
</tr>
<tr>
<td>4</td>
<td>Silage</td>
<td>corn silage, conventional tillage</td>
</tr>
<tr>
<td>5</td>
<td>Silage</td>
<td>corn silage, alternate no-till/conventional till</td>
</tr>
<tr>
<td>6</td>
<td>Silage</td>
<td>corn silage, continuous no-till</td>
</tr>
<tr>
<td>7</td>
<td>Grain</td>
<td>Grain Sorghum, conventional tillage</td>
</tr>
<tr>
<td>8</td>
<td>Grain</td>
<td>Grain Sorghum, no-tillage</td>
</tr>
<tr>
<td>9</td>
<td>Oil Seed</td>
<td>Soybeans</td>
</tr>
<tr>
<td>10</td>
<td>Dbl. Crop</td>
<td>Winter Wheat/Soybeans, no lodging expected</td>
</tr>
<tr>
<td>11</td>
<td>Dbl. Crop</td>
<td>Barley/Soybeans, no lodging expected</td>
</tr>
<tr>
<td>12</td>
<td>Dbl. Crop</td>
<td>Rye/Soybeans, no lodging expected</td>
</tr>
<tr>
<td>13</td>
<td>Dbl. Crop</td>
<td>Oats/Soybeans, no lodging expected</td>
</tr>
<tr>
<td>14</td>
<td>Dbl. Crop</td>
<td>Winter Wheat/Soybeans, lodging expected</td>
</tr>
<tr>
<td>15</td>
<td>Dbl. Crop</td>
<td>Barley/Soybeans, lodging expected</td>
</tr>
</tbody>
</table>

- Highlight a selection and click **OK** to place the crop into the grid. When a crop's yield goal is entered, the crop's phosphate uptake per unit yield and the crop's total phosphate uptake per acre are shown in the appropriate columns.

**NOTE:** Small grains (barley, oats, rye and wheat) may be marked to account for straw removal by right clicking on the cell displaying the crop name. The cells displaying the
phosphate uptake per crop unit yield and the total uptake per acre will turn green and both of the values for phosphate uptake will increase accordingly.

- If 3 crops may be grown in a 2-year period, a third crop may be added to the plan, and the same procedures and calculations will apply. Remember that a double crop will show and count as two separate crops because of the individual phosphate uptake characteristics of each crop.

- If the final phosphate uptake is not equal to or greater than the total phosphate supplied by the manure, the plan needs adjustment. Examine the crops that were selected and their yields or modify the application rate of the manure so that all applied phosphate has been removed.

Note the following example of a completed Transport P Calculation indicating that all applied phosphate was removed by the crops within the plan:

- To view the recommendations for each crop, click on the cell to the left of the first crop to select it.
Display the **Recommendations** page. The first crop will be listed in the upper right hand box and the recommendation for that crop will be shown on the page. Enter the planned **Days** to soil incorporation when utilizing the manure.
- Return to the **Scenarios** page and select the second crop.

- Organic history information will be automatically deposited into the new first column on the **History** page as applicable.
• Adjust the history information if necessary. Return to the Recommendations page to see the second crop recommendation.

• If applicable, repeat this last sequence of commands to display the third crop in the plan.
To return this field to a standard scenario plan, uncheck the Trns P Rem box on the Scenarios page. Unchecking the box, will discard any Transport Manure data. If a Transport P Removal plan will be prepared, it will be necessary to repeat the process from the beginning.

Save the farmer’s file frequently, particularly when preparing a Transport Manure P Removal Plan for a field as many steps are involved in the planning process.

F. Special Scenario Functions

Several fields within a farming operation may use similar management scenarios. NuMan Pro allows management decisions made in one field to be duplicated and applied to a larger number of fields. These management decisions may include the selection and quantity of an organic material to be applied as indicated in the Organics Grid, as well as crop selection and yield goal information as indicated in the Crop Grid.

Display the field containing the completed management information as the current Scenario page. To open the extend dialogue, click the Extend icon on the Tool Bar or highlight the Extend selection in the Edit menu and press the Enter key.
The source field will be on the left side of the dialogue and all eligible target fields will be on the right side of the dialogue. Highlight all the fields to which the same organics and crop selection information should be extended. Click the OK button and the information on the source field's scenario page, plus the fine tuning adjustments made on the Recommendations page, will be duplicated among all the fields selected.

Fields are not eligible as extend targets if their recommendations have been locked in the check box on the Recommendations page or if the field has been designated for a phosphorus-removal plan.

If soil analysis information has not been entered for a target field, only the Scenario page information will be extended to that field. Any fine tuning adjustments made on the recommendations page will not be extended because a soil analysis is required in order to generate a recommendation.
XI. Phosphorus Site Index

The Phosphorus Site Index, PSI, is an evaluation tool used when the FIV-P is greater than 150, and the farmer intends to apply phosphorus in any form. The results may restrict the type of plan and amount of phosphorus that may be used.

The PSI portion of NuMan Pro is accessed from the Tool Bar by clicking on the icon. Note that the tabs across the top of the page change.

The Farmer/Consultant tab stays the same. The Field tab remains, but content reflects PSI and the options for RUSLE calculation. The remaining tabs to be filled out will depend upon the selection made for RUSLE on the Field page.

- If RUSLE 1 will be internally calculated, all tabs will need to be addressed.
- If RUSLE 1 or RUSLE 2 factors are obtained externally, address Part A and Part B.
- If RUSLE A from soil conservation plan is used, address Part A and Part B.
A. **LS Factor**

The **LS Factor** page is used to describe the topographical characteristics of the current field.

At the top left corner of the page is a box indicating the number of slope segments within the current field. The maximum number of segments is 10.

**Change the number of segments** by clicking on the small arrows right or left of the box or click the cursor inside the box and use the keyboard’s Right Arrow and Left Arrow. The program will generate an equal number of columns in the **Segment Grid** two rows below this box.

The ratio of **rill to interrill erosion** that is likely to occur within the field is selected in the second row drop-down box. Most agricultural land with row crops has a moderate ratio of rill to interrill erosion. Steeply sloping land tends to have a high ratio while land that is flat or has permanent heavy cover tends to have a low ratio.
Select the box by clicking on the down arrow and then click on the desired selection.

The Segment Grid occupies the next set of rows.

<table>
<thead>
<tr>
<th>Segment #</th>
<th>1</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gradient, %</td>
<td>7.0</td>
<td>3.0</td>
</tr>
<tr>
<td>S.Length, ft</td>
<td>100</td>
<td>200</td>
</tr>
</tbody>
</table>

Enter the percent land gradient and field segment length for each corresponding segment. At the left end of the grid are header rows indicating each row’s data: Segment # (number), Gradient % (percent), and S (slope) Length. Click in the appropriate cell or press the Shift key with the focus in the cell to enter the slope gradient and slope length values. Press the Tab key to finish the edit and move to the next cell in the row (or out of the grid).

To the right of the Segment Grid are several boxes with values resulting from user input.

<table>
<thead>
<tr>
<th>3.948</th>
<th>Equ. Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>300</td>
<td>Horiz. Length</td>
</tr>
</tbody>
</table>

The current field’s average Horiz. Length (horizontal length) and the Equ. Slope (equivalent slope) are displayed in the correspondingly labeled boxes. The values in these boxes represent values calculated by the program with the background shaded yellow indicating that these values cannot be directly edited.

At the right middle of the page, is a Revert button. This button will return the LS data on this page to a pre-edited state providing no other field has been displayed and the file has not been saved since the data have been edited.

In the lower portion of the page is the Surface Impact entry box that is used to enter K Factor data required for the C Factor calculation.

A drop-down list box is used to enter the surface cover function. Changing the surface cover function label will cause the descriptive text in the blue surface impacts box to change. Enter the percentage of rock cover on the soil surface for the current field. Select and input the appropriate values in each of these boxes. The impacts of these values will be calculated and
displayed on the K Factor and Index Part A pages. The Revert button within this section will return only the K Factor data on this page to a pre-edited state providing no other field has been displayed and the file has not been saved since the data have been edited.

The resulting Overall LS factor will be displayed at the top right corner of this page as well as deposited in the appropriate box on the Maryland PSI Index Part A page.

Overall LS 0.622

B. C Factor

Management practices for the current field are declared on the C Factor page. Depending on the Vegetation choice made near the top right corner of the page (Rotation or Pasture), the page will present different management choices. The Overall C Factor will be displayed in the top right hand corner of the page.

Overall C 0.1190

If Pasture is chosen, determine the whether the field is Pasture or a Grass/Grass-Legume Hay and indicate the Percent Ground Cover. The eight options represent mutually exclusive choices. Click the description which most closely represents the actual conditions of the field.

<table>
<thead>
<tr>
<th>Crop Type / Management</th>
<th>% Ground Cover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grass or Grass Legume Hay</td>
<td></td>
</tr>
<tr>
<td>Pasture</td>
<td></td>
</tr>
<tr>
<td>Intensive grazing</td>
<td>&gt; 80 %</td>
</tr>
<tr>
<td>Continuous grazing</td>
<td>&gt; 60 %</td>
</tr>
<tr>
<td>Over Grazed</td>
<td>&gt; 40 %</td>
</tr>
<tr>
<td>Heavy Traffic Areas</td>
<td>&gt; 20 %</td>
</tr>
<tr>
<td></td>
<td>80-100 %</td>
</tr>
<tr>
<td></td>
<td>50-80 %</td>
</tr>
<tr>
<td></td>
<td>20-40 %</td>
</tr>
<tr>
<td></td>
<td>&lt; 20 %</td>
</tr>
</tbody>
</table>

If Rotation is chosen, a header row will appear showing Crop, Operation, Early or Late, the months of the year, and Res (residue). Along the right side of the page are two buttons used to add or remove crops and two more buttons used to add or remove field operations.

Click Add to see a list of crops. Select one crop at a time and enter its Yield. Check Senescence when appropriate, then click Add.
In the **Operations** box, click **Add** to see the available management practices.

Scroll to display a desired operation. First hold down the **CTRL** key, then click to **highlight** the operation. **Repeat** the selection process **for additional operations while continuing to hold down the CTRL key**. After all selections have been made (up to 10 per crop), release the **CTRL** key and click **OK**.

In the **Crop Rotation Grid**, each crop, operation, and timing of each operation in the rotation is declared.
Each crop has an identifying number on the left. Place the management operations for each crop in **chronological order** by clicking and holding on the name of the operation while moving it up or down. Release when it is in the right location.

Indicate the approximate **time period** when the operation is performed. Click to place marks in the rows when operations occur. A blue X marks the month of the operation and a red X indicates whether it is early or late within the month.

Right-click on the crop number to open a box asking if this crop will be associated with the current set of operations.

Crops and their associated operations will be divided from one another by heavier grey lines. Let the cursor hover over the crop number to show the crop name and its associated operations.

Click and hold on the number of a crop, keep holding while moving the cursor up or down in the rotation order and sideways into the operations column. Release the cursor to change the order of the crops and their associated operations.

The background grey of the grid will note each December to January boundary with a change of shading and the total number of years in the rotation will be displayed in a box in the upper right corner of the pages, under the **Overall C** box.
Repeat the steps until all crops in the full rotation are listed in the order to be grown and the associated operation are listed in the order to be performed.

Enter the amount of residue added or removed where applicable or residue amounts may be automatically calculated for some crops based on that crop yield goal. Using the supplied information, the overall C Factor for this field will be displayed in the box in the upper right hand corner of the page and in the appropriate place on the Part A page of the Phosphorus Site Index.

Maintenance crops (crops that were planted in previous years) will be available in this list only after the associated establishment crop has been previously placed into the Crop Rotation Grid.

The number of years in the rotation will be displayed immediately below the Overall C Factor.

To use the Bundle button feature:

- Scroll to display and then select a desired operation.

- Scroll to display the next desired operation, first hold down the CTRL key and then select the operation. Repeat this process until all operations for this crop have been selected (up to 10). Click OK. Operations do not need to be selected in the order to be performed. Placing operations in chronological order is performed in the next step.

The selected set of operations will be placed into the grid, listed alphabetically and grouped together in consecutive rows. This group of operations will be separated from other groups of operations by a thickened line. To the left of each group of operations will be a grid header containing the identification number of the associated crop. Only a crop identification number is displayed here, to save space on the page. The full crop name may be momentarily displayed, in a tool tip, by hovering the mouse cursor over the header cell containing the identification number. Tool tips do not function without a mouse or other pointing device.

- Place the operations in chronological order (the order they will be performed) by moving them up or down within their own group using a left click/drag and drop of a mouse or with the Up and Down arrow keys on the numeric keypad, and with the NumLock key in the on position. Position the cursor focus on the operation to be moved with the regular Arrow keys. Move the operation up or down with the numeric key pad Arrow keys.
A crop and all of its associated operations may be moved up or down in the **Crop Rotation Grid**.  

**With a mouse;**

- Drag and drop the crop header, of the crop to be moved, onto the group of operations of a crop positioned adjacent to the desired location of the crop being moved.

**With a keyboard;**

- Place the cursor focus in the group of operations of the crop to be moved.
- Press the **C** key. The associated crop header will change color signifying the crop and operations to be moved.
- Place the cursor focus on the group of operations of the crop positioned adjacent to the desired location of the crop being moved.
- Press the **Space Bar** to complete the process.
- Repeat the steps described above until all of the crops in the full rotation for the current field are listed in the order to be grown and the associated operations are listed in the order to be performed.

The following steps establish a time schedule for the listed operations.

- **With a Mouse**, click a cell in the grid to place a timing mark or enter a value.
- **With the Keyboard**, position the cursor focus with the **Arrow** keys.
- Press the **Space Bar** to place a timing mark or enter a value.
- Place a timing mark in the row of each listed operation underneath the month it will be performed.
- Also in the row of each operation, place a timing mark in either the **early** or **late** column to indicate the relative time within the month that the operation will be performed. The background of the grid will note each December to January boundary with a change of shading and the total number of years in the rotation will be displayed in a box in the upper right corner of the page, under the **Overall C** box. Only six (6) successive operations are allowed in any one fifteen-day period and only one December to January boundary is allowed for each crop. Note that more than one crop may be grown in a
single calendar year. The grid will signify timing selections that are not chronologically
logical by changing to a RED colored row where the logic error begins.

A white cell in the far right column of any row denotes a required residue value (either
added or removed) that must be supplied by the user. Enter an appropriate value into
all of these cells.

To replace a crop, double-click on the cell containing the **Crop Identification Number** or use the
keyboard combination **Ctrl+H** with the cursor focus on an operation of the crop to be replaced.
The list of all the available crops will appear. Scroll to display and then select the replacement
crop. In this dialogue one and only one crop may be selected at a time. Input the appropriate
yield goal and make the appropriate senescence selection. When finished click **OK**. The newly
selected crop will replace the previous crop in the **Crop Rotation Grid**.

To remove a crop, and all of the operations associated with it, place the cursor focus on any cell
containing an operation next to the crop identification number to be removed and then click
the crop **Remove** button. All information referring to this crop will be removed and the grid will
be appropriately reduced.

To add an operation, place the cursor focus within the group where the new operation is to be
inserted, click the operation **Add** button. The list of operations will appear. Scroll to display and
select the desired operation. The newly selected operation will appear in a new row within the
group. If necessary move the operation into the correct chronological placement.

To replace a single operation, double-click on the operation to be replaced or use the keyboard
combination **Ctrl+J** with the cursor focus on the operation to be replaced. The list of operations
will appear. Scroll to display and click to select the replacement operation. Click **OK** and the
selected operation will replace the original operation in the Grid.

To remove an operation, place the cursor on the operation to be removed to select it. Then
activate the operation **Remove** button.

If a particular set of operations is usually performed, associated with a particular crop, this set
of operations can be "bundled" together and each time that crop is selected for a crop rotation
the set of operations may be selected together with the use of the **Bundle** button on the crop
selection dialogue.
The "Fallow Crop" selection in Crops List exists so the user may account for a complete year and/or years, within a crop rotation, where no crop will be planted. A "No Operation" selection will be automatically entered for the list of operations so a chronological place holder will be present for each Fallow Crop within the Rotation Grid. The timing mark for the first Fallow Crop must be placed in, or to the left of, the column for the month of June and each successive Fallow Crop timing mark should be placed in a preceding month to designate an additional year in the rotation. It is suggested that the Fallow Crop only be used if no crop will be planted for a complete year.

<table>
<thead>
<tr>
<th>Crop</th>
<th>Operation</th>
<th>Early</th>
<th>Late</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>234</td>
<td>no operation</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The user should ensure that the grid indicates no chronological logic errors and that the total number of Years desired in the rotation are displayed in the upper right corner of the page. When all of the crop rotation information has been entered, the same information can be extended to other fields (similar to the nutrient management scenario).

C. Special C Factor Scenario Function

Many times several fields within a farming operation will use similar cropping management scenarios (C Factor) to reduce soil erosion losses. NuMan Pro allows the user to duplicate cropping management decisions in a field to a larger number of fields. These management decisions may include the use of crop rotations and tillage management systems. Once crop rotation and all associated operations have been selected, ordered chronologically and all timing selections have been declared, this same C Factor information may be duplicated for a larger group of fields.

Display the field containing the completed management information as the current C Factor page. To open the extend dialogue, click the Extend icon on the Tool Bar or highlight the Extend selection in the Edit menu and press the Enter key. The source field will be on the left side of the dialogue and all eligible target fields will be on the right side of the dialogue. Highlight all the fields to which the same C Factor management information should be
extended. Click the OK button and the information on the source field's scenario page will be duplicated among all the fields selected.

The C Factor extend process is restricted to fields that have the PSI component of NuMan Pro as being active for that field.

D. P Factor

The **P Factor** page is used to describe the supporting management practices that will be utilized in a field to reduce soil erosion. The overall P factor is displayed in upper right corner of the page.

The **Contour** farming sub-factor button is located at the upper left corner of the page and the Terraced practices sub-factor button is located near the top center of the page.

Next to each sub-factor button is a text box for directly entering the sub-factor value or, if the button is selected, the sub-factor value will be calculated from user input. Once the sub-factor button is selected, a data input dialogue will be displayed.

If the Contour button is selected, two drop-down list boxes and one text box will appear below the button.

The first drop-down list contains 6 choices of crop ridge height codes to be utilized in the cropping management within the field with ridge heights indicated to aid in selection of an appropriate value.
The text box is used to indicate the percent of the furrow grade from level that will be utilized in the field.

| Furrow grade, % | 0.0 |

The second drop-down list contains 8 cover management codes to describe the soil surface cover condition that will exist in the field following planting and/or the average during most of the year.

```
Cover management code
5. C5 - light cov. and/or mod. rough
1. C1 - estab. sod-forming grass
2. C2 - 1st year grass or cut for hay
3. C3 - heavy cov. and/or very rough
4. C4 - moderate cov. and/or rough
6. C6 - no cover and/or min. rough.
7. C7 - clean tilled, smooth, fallow
8. VR - very rough with stubble
```

The **Stripcropping** sub-factor button is located about mid-way down the page on the left side of the page.

Next to the **Stripcropping** sub-factor button is a text box for directly entering the sub-factor value or, if the button is selected, the sub-factor value will be calculated from user input. Once the sub-factor button is selected, a data input dialogue will be displayed.

Once the **Contour** sub-factor button has been selected, the **Stripcropping** button will be enabled and available for use.

| Stripcropping | 1.000 |

If the field's Slope Length and Steepness information has not been previously entered, selecting the **Stripcropping** button will switch the display to the Slope Length and Steepness page so that information may be entered. After the Slope Length and Steepness information is entered, the user may then return to the **P Factor** page and select the **Stripcropping** button.

Selecting the **Stripcropping** button will display an annual stripcrop rotation grid and a grid control.

[Grid control]
The grid control allows the user to input the number of years within the stripcrop rotation up to 10 years.

<table>
<thead>
<tr>
<th>Year 1</th>
<th>Year 2</th>
<th>Year 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>1 60 2.0</td>
<td>6 300 4.0</td>
<td>6 50 7.0</td>
</tr>
<tr>
<td>2 60 5.6</td>
<td>6 30 7.0</td>
<td></td>
</tr>
<tr>
<td>3 60 9.0</td>
<td>6 40 5.0</td>
<td></td>
</tr>
<tr>
<td>4 50</td>
<td>6 80 3.0</td>
<td></td>
</tr>
</tbody>
</table>

The grid will expand and will provide scrolling when the stripcrop rotation exceeds 7 years as only 7 years of the rotation will be visible at any one time. The length across the strips within the strip-cropping rotation may be displayed as either a % of the slope length to the bottom of the strip or as a strip width in feet. The user chooses the method to input strip length by choosing the appropriate radio buttons: *Strip bottom as % of slope* or *Strip width in feet*. If the *Strip bottom as % of slope* radio button is chosen, then the length of the strips is designated by defining the bottom edge of each strip as a percent of the total field length (in relation to the top of the field). If the *Strip width in feet* radio button is selected, then the lengths of the strips are input into the grid in units of feet.

In the second row of each yearly column is a control that is used to declare the total number of strips for that year of the rotation. Use the small up and down arrows, at the right end of the control in each column, to increase or decrease the number of strips (down to increase and up to decrease).

The grid allows for up to 10 strips within any one year of the rotation. Three sub-columns, within each year column, correspond to the soil surface vegetative cover / soil surface roughness (i.e. choices 1 through 7), relative position of each strip, and percent steepness of each strip. The percent steepness is automatically calculated based on previously entered information from the Slope Length and Steepness page. When the cursor is allowed to hover over the grid, a tip window appears to the right of the grid to inform the user of the type of information that should be input into each cell.
Midway down the central portion of the page is a **Subsurface drained** sub-factor button where an index value (0.6-1.0) for subsurface drainage may be entered.

If the **Terraced** button has been selected,

two additional text boxes and an **Open Outlet %** button will appear below the **Terraced** button.

The user may enter the horizontal interval between terraces, in feet, within the first text box.

Once the **Open Outlet %** button has been selected, the user may enter the percent grade of the terrace outlet in the second text box.

A **Revert** button is provided so that the user may return the **P Factor** page to a pre-edited state prior to displaying any other page.

---

**E. PSI – Index Part A – Site and Transport**

The PSI **Index Part A** calculates the potential loss of phosphorus due to site and transport characteristics. Text boxes with light gray or yellow backgrounds are informational boxes indicating the results of user choices on previous pages and may not be edited from the current page. Text boxes with white backgrounds may be directly edited from the **Index Part A** page.

The column of text boxes with blue backgrounds on the right side contain sub-component PSI index values calculated from user-supplied information in that associated line. The bottom blue box, labeled **Total Site and Transport Value** is the final PSI **Index Part A** value.
Depending upon the RUSLE option that was selected on the Field page, the top row of the Index Part A page will be configured and displayed differently.

- If the **Internally calculated RUSLE 1** option was selected, all text boxes in the top row will be yellow and data will already be entered based upon input from previous pages.

- If the **RUSLE 1 or RUSLE 2 factors externally calculated** option was selected, the LS, C and P factors will allow input as indicated by the white background. Values for K and R factors will be already set based on previous user input on other pages.

- If the **Input RUSLE A from a soil conservation plan** option was selected, user input will be limited to a single text box for inserting the RUSLE A value from the soil conservation plan.
In the second row, **Hydrologic Soil Group** and **T-Factor** are based upon the soil map unit previously selected on the Field Page and are not editable. These values are NOT used in the RUSLE calculation. Hydrologic Soil Group value is useful in determining the P Factor. T-Factor value is useful in determining if the RUSLE A is within allowable soil loss from the current field.

```
+-------+-------+
| HSG   | T-Factor |
|       | 5      |
```

**Artificial Drainage** and **Concave** have a pronounced effect on the subsurface drainage class value and the soil runoff class value, respectively.

<table>
<thead>
<tr>
<th>Artificial Drainage ?</th>
<th>Concave ?</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Enter the percent **Field Slope** if editable. This box will not be editable if Simplified RUSLE was selected on the Field page.

Below center, is a row of selectable cells that represent user management decisions within three categories. Click to select a cell and the background will change to green. Click again to deselect.

The **Distance to Surface Water** category is on the left and presents two selections for describing the distance to surface water: (1) greater than or equal to 100 feet and (2) less than 100 feet. Click one of the boxes to select the appropriate distance.

```
<table>
<thead>
<tr>
<th>Distance to Surface Water</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;= 100'</td>
</tr>
<tr>
<td>&lt; 100'</td>
</tr>
</tbody>
</table>
```

The **Permanent Vegetative Buffer** category is the middle category and presents three selections for describing the perpendicular distance across the vegetative buffer to the end of the field. Click to select the appropriate buffer category: (1) greater than or equal to 50 feet, (2) greater than or equal to 25 feet but less than 50 feet, or (3) less than 25 feet.

```
<table>
<thead>
<tr>
<th>Permanent Vegetative Buffer</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;= 50'</td>
</tr>
<tr>
<td>25'- 50'</td>
</tr>
<tr>
<td>&lt; 25'</td>
</tr>
</tbody>
</table>
```

The **No P Application Zone** is on the right and presents two selections for describing the distance from the edge of the field to the location where phosphorus has been applied in the field. Click to select (1) greater than or equal to 25 feet, or (2) less than 25 feet.
If valid selections are not made in all categories, the program will not calculate a Total P Loss Rating.

<table>
<thead>
<tr>
<th>Distance to Surface Water</th>
<th>Permanent Vegetative Buffer</th>
<th>No P Application Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;= 100’</td>
<td>&lt; 100’</td>
<td>&gt;= 25’</td>
</tr>
<tr>
<td>&gt; 50’</td>
<td>25’- 50’</td>
<td>&lt; 25’</td>
</tr>
<tr>
<td>&gt;= 25’</td>
<td>&lt; 25’</td>
<td></td>
</tr>
</tbody>
</table>

At the bottom of the page are boxes displaying the **Total Site and Transport Rating** and the **Total P Loss Rating** for the current field. The background color of the Total P Loss Rating box will change in association with the range thresholds as stated in the Maryland Nutrient Management Manual.

If any data is missing, *** will be displayed in the box for P Loss Rating or Total Site and Transport Value.

### F. PSI – Index Part B – Source and Management

**Index Part B** calculates the potential loss of phosphorus due to source characteristics and management practices. Text boxes with light gray or yellow backgrounds are informational boxes indicating the results of user choices on previous pages and may not be edited from the current page. Text boxes with white backgrounds may be directly edited from the **Index Part B** page.
Enter the amount of Starter Fertilizer P$_2$O$_5$ in the upper left corner. Allow the cursor to hover over the box to see the allowable amount of starter fertilizer for this crop.

0 Starter Fertilizer P$_2$O$_5$

The soil test P-value and the name of the soil testing laboratory are displayed as entered on the Soil page previously.

13 Soil P Bray F1, A & L

Fertilizer-P and Organic-P values from the field’s Recommendations page from the Nutrient Management Component are transferred and displayed.

7 Rec./Ren. Fertilizer P, Appl. Rate, Lbs 60 Organic P

The Soil Phosphorus Fertility Index Value (Soil P FIV) is displayed in a blue box.

28 Soil P FIV

The Phosphorus Application Grid begins on the third line of the page. The pounds per acre of commercial fertilizer P$_2$O$_5$ are on the left. The pounds per acre of organic (manure or sludge) P$_2$O$_5$ are on the right.
Utilizing previous information from the Recommendations page, NuMan Pro will show the total quantity of fertilizer and/or organic P2O5 on the appropriate side(s) of the grid. The total amount for each category will initially appear in the 1st app (application) column. The columns labeled 1st, 2nd and 3rd app allow the quantities to be split into a maximum of three applications for each of the two types.

In the next four rows of the Phosphorus Application Grid are boxes for entering markers to indicate timing or method for each of the application splits. They are:

- Injected or banded at least 2 inches below the soil surface
- Incorporated within 5 days of application
- Surface applied between March and November or incorporated more than 5 days after application
- Surface applied between December and February

1.) Quantity

If the waste material will be completely applied in the First Application, skip to Method.

If this First Application amount is to be split among two or three applications:

- Place the cursor in the box, containing the number, at the top of the first column. A click of the mouse or press the Shift key and the value will become editable.
- Edit this number to reflect the quantity to be applied in the First Application.
- Press the Tab key and the remaining amount will be deposited into the second column.

If the remainder of the phosphorus will be applied in this Second Application, skip to Method.

If this Second Application amount is to be split among two applications:

<table>
<thead>
<tr>
<th>1st app</th>
<th>2nd app</th>
<th>3rd app</th>
<th>Application methods</th>
<th>1st app</th>
<th>2nd app</th>
<th>3rd app</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fert --&gt; Totals --&gt; Org</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inject. banded. below surf. at least 2&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Incorpor. within 5 days of appl.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Surf. appl. Mar-Nov or incorp. after 5 days from appl.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Surf. appl. Dec-Feb</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Application Method Index Values</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

84
- Edit this number to reflect the quantity to be applied in the Second Application.
- Press the Tab button and the remaining amount will be deposited into the third column.

2.) Method

As application quantities are entered into each column, the program automatically selects the fourth method of application (Surf. appl. Dec-Feb) by default. Change this selection to reflect the desired method.

In each column that contains a quantity of P₂O₅, click in the text box below the column quantity to enter an application marker or place the cursor focus in the desired text box and press the space bar to enter the marker.

Repeat this process for both sides of the grid as applicable.

The quantity of phosphorus applied in each split application will be used in conjunction with total quantity of phosphorus applied and the application method to calculate a weighted average risk assessment. This weighted average value will be displayed at the base of each column within the grid as an Application Method Index Value.

<table>
<thead>
<tr>
<th>1st app</th>
<th>2nd app</th>
<th>3rd app</th>
<th>Application methods</th>
<th>Application Method Index Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td></td>
<td></td>
<td>Fert. &lt; Totals -&gt; Org</td>
<td>7.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Inj. band. below surf. at least 2&quot;</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Incorp. within 5 days of appl.</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Surf. appl. Mar-Nov or incorp. after 5 days from appl.</td>
<td>×</td>
</tr>
<tr>
<td>60.0</td>
<td>Application Method Index Values</td>
<td>22.5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

All applicable method values will be added and carried forward to the far right column on the Index Part B page into the total P Application Method Value for the category of material (fertilizer or organic).

3.) None Applied

If no quantity is transferred from the Recommendations page into either the Total P₂O₅ Application Rate box at the top of the grid, the associated grid components will remain inactive for that side of the grid.
If any of the application quantities need to be edited, place the cursor on the quantity to be edited. Edit the application quantity as needed and repeat the rest of the **Phosphorus Application Grid** procedure from that point.

If only a selected application method needs to be edited, click in the text box corresponding with the new application method selection and the marker will be moved to the new text box.

If any data is missing on either Index Part A or Index Part B, *** an **Incomplete Data** will be displayed.

The **Total Management and Source Value** is displayed in a box with a blue background near the bottom right of the page. The **Total P Loss Rating** is displayed in a box near the bottom left.

The background color of the box displaying the **Total P Loss Rating Value** will change in association with the range thresholds as stated in the Maryland Nutrient Management Manual.

0-50       Low       Green
51-75      Medium    Pale Yellow
76-100     High      Dark Yellow
>100       Very High  Pink

The **Generalized Interpretation** associated with the rating is presented in the large text box across the bottom of the page.
G. Cloning PSI Scenarios

It is sometimes advantageous to create clones of an existing PSI scenario. The clones may then be modified to evaluate how changes in management practice will affect the PSI. Within a rectangular box on the right side of both the Part A and Part B pages, there are four buttons and a drop-down list box.

Clicking Create will create a new clone. Remove will remove only the displayed clone. Make Prim will exchange the currently displayed clone and the original, making the current clone primary. Rem Clones will remove all clones leaving only the original primary PSI scenario. Arrows in the drop-down list at the bottom can be used to navigate between PSI clones.

To create a clone for the current field, go to either the Index Part A or Index Part B page. Click Create and Enter the number of clones desired. Click OK.

NuMan Pro will create duplicates of the current primary PSI scenario within the current field record. The first cloned field will be displayed on the Index page. Navigate between clones using the drop-down list at the bottom of the clones section on either Index Part A or Index Part B.

Components of PSI Index Part A and Index Part B may be altered to adjust the overall Index Rating in each of the different clones. The RUSLE Factors will not be cloned and will remain the same for all clones. Likewise, Soil Test P and application rates of phosphorus will be derived from the "Primary Scenario" (in the Nutrient Management view) for the current field.

It is strongly encouraged to save frequently to avoid inadvertently losing work.
When using cloned fields to compare different PSI scenarios, after one clone scenario is chosen to be implemented, that scenario must be marked as primary. Display the desired scenario, then click Make Primary. The previously primary scenario will exchange places with the selected clone. At the appropriate time, delete all remaining clones using the Remove Clones button, to leave only one PSI scenario for a particular field. Once the desired primary scenario is chosen, save the file.
XII. Recommendations

The Recommendations page displays all fertilizer and organic material recommendation information. The Crop Needs Grid in the upper left corner of the page displays the nitrogen (N), phosphate (P<sub>2</sub>O<sub>5</sub>), and potash (K<sub>2</sub>O) crop needs based on soil analysis results and anticipated crop yields if applicable. Any applicable nitrogen credits are also listed in this portion of the grid. A central portion of the Crop Needs Grid is used to display the units of measurement used on the Recommendations page unless otherwise indicated (i.e. the amounts of organic materials may have specific units as indicated in the Organics Grid). In the upper central portion of the page is the Scenario list where all possible scenarios (crop/org. combinations) will be shown.

The main central portion of the Recommendations page contains the Recommendations Grid which is divided into two parts. The upper part is for organic material recommendations. The lower part is for commercial fertilizer recommendations or fertilizer supplements of organic recommendations.

At the far upper right corner of the page is the Agronomic Lime Recommendation (AG lime rate, t/A) text box. At the upper right center of the page is the Organics Toggle button. Below the Organics Toggle button is the PSNT button. To the left of the PSNT button is the Notes button and below the Notes button is the Lock check box.

### Nutrient Management

<table>
<thead>
<tr>
<th>Crop Needs</th>
<th>N</th>
<th>P&lt;sub&gt;2&lt;/sub&gt;O&lt;sub&gt;5&lt;/sub&gt;</th>
<th>K&lt;sub&gt;2&lt;/sub&gt;O</th>
<th>M</th>
<th>Crop</th>
<th>Org</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logano credit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximo credit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadox credit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appl Split 1</th>
<th>N</th>
<th>P&lt;sub&gt;2&lt;/sub&gt;O&lt;sub&gt;5&lt;/sub&gt;</th>
<th>K&lt;sub&gt;2&lt;/sub&gt;O</th>
<th>Amount</th>
<th>Units</th>
<th>Incore</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appl Split 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appl Split 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Organic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Fertilizer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The data displayed on this page depend on the recommendation scenario that has been selected from the Scenarios List in the upper right corner of the page. All permutations derived from the data entered on the Scenarios page may be viewed. Scroll, if necessary, to locate the desired scenario and place the cursor on the listing to highlight it. The page will display the recommendation for the highlighted crop and organic material combination.

If the highlighted scenario contains an organic material, the page will display an organic recommendation and the word ORGANICS will appear in the top left cell of the Recommendations Grid. If no organic material is indicated on the Scenarios page, a fertilizer recommendation will be the only recommendation type available for that field and the word ORGANICS will not be displayed in this cell.

For a field receiving organic materials, the basis of the recommendations will be indicated by a red background cell at the top of the Crop Needs Grid. The highlighted red cell will be N for a nitrogen-based plan, P₂O₅ for phosphorus-based, K₂O for potassium-based, or the blank cell at the far left for a Pre-Set rate.
If no organic material is indicated on the Scenarios page, there will be no basis highlighted and the Organics toggle button, at the right center of the Recommendations page, will also indicate NO ORGANICS.

When organic recommendations are displayed, a fertilizer recommendation for that crop can be viewed by clicking the Organics toggle button.

The word ORGANICS will disappear and all information about recommendations for the organic material will be removed from the page. The displayed recommendation will change to reflect a fertilizer only recommendation.

Click the Organics toggle button again and the page will return to the previously displayed organics recommendation. This process can be repeated for all scenarios in the list.

Fertigated crops display a non-standard recommendation grid similar to the one below which shows multiple applications of fertilizer via trickle irrigation under black plastic.

When doing the PSI for a fertigated crop field, enter percent (%) of area under plastic at the bottom of the table on the Recommendations page. This will convert the recommendation from pounds of fertilizer per mulched acre (lbs/FMAc) to pounds of fertilizer per acre (lbs/Ac).
The total P2O5 recommendation for the field in lbs/Ac, will be displayed at the bottom of the table. This amount will be transferred to the Fertilizer P2O5 box on the PSI part B page, for use in the PSI calculation.

If the PSI result for the field does not allow a P recommendation at that level, return to the recommendation page and reduce the amount of P recommended:

- Right click on a P application to set it to 0. The background of the box will turn white.
- Left click within the white box and type in an amount other than zero, but less than the amount originally recommended.
- To restore the original P application, right click on the application again.

Any notes which accompany a recommendation may be viewed by clicking on the View Notes button at the bottom right corner of the page.

The Notes viewer will appear and all notes associated with the selected crop will be displayed. Click OK to close the Notes viewer.
The **PSNT** button is only used when corn is the primary crop. PSNT accesses the Pre-Sidedress Nitrate Test dialogue where data gathered from the field test may be entered. PSNT worksheets and reports may be printed from the **Print PSNT** option on the **File** menu.
A. Nitrogen Excesses

NuMan Pro is intended to provide recommendations for optimum crop utilization of nitrogen, therefore any scenario which results in a nitrogen excess (at any point) will be flagged in several ways.

The Recommendation Page Tab will turn to a X and there will be a Question Mark (?) to the left of the crop/organic listing with the nitrogen excess.

If the crop has either a manual or mandatory nitrogen split, and one or more of the split(s) is/are in excess, the background color of the cell containing the excess nitrogen amount will turn red.

In the case of an excess of the crop’s total nitrogen requirement, a red warning message will appear in the lower right hand area of the page.

A scenario containing a nitrogen excess will not print because it is outside the scope of UME nutrient recommendations. It is the user’s responsibility to adjust the scenario to eliminate the nitrogen excess. This type of adjustment can be made in a variety of places. Depending on where the adjustment is made, the adjustment may affect other scenarios for the same field.
B. Multiple Crops per Year

If a PSI will be performed on a field with multiple crops grown in the same year, the crops may be grouped together so that their P recommendations can be considered together for the PSI calculation.

Indicate multiple crops that will be grown in the same year by right clicking next to the crops in the multicrop column (M), in the crop list, on the recommendation page. An M will appear next to the crop name. To remove the multiple designation, right click again.
C. Fine Tuning Recommendations

An organic recommendation may be fine tuned for crops such as small grains that agronomically require split applications of organic nutrients. These crops will automatically produce recommendations with more than one application for a single organic material, split according to the crop’s nitrogen requirements.

In these special cases, individual organic applications may be eliminated from the recommendation if the material cannot be effectively applied with existing waste application equipment or if a fertilizer application is preferred to replace one of the organic splits. Click on the header cell to the left of the split in question to remove that particular split from the recommendation. The header cell will change color to flag this adjustment. Once the split is removed, a fertilizer equivalent will be displayed in the fertilizer portion of the Recommendations Grid in the line with its associated application method. A second click of the mouse on the header cell will remove the mark and restore the split.

The same fine tuning adjustment can be accomplished with the keyboard. With the cursor in the Recommendation Grid, the letter keys a, b and c will act on the first, second and third split respectively. Pressing the a key once will remove the associated split. Pressing it again will restore the split.

<table>
<thead>
<tr>
<th>N</th>
<th>P2O5</th>
<th>K2O</th>
<th>M</th>
<th>#</th>
<th>Crop</th>
<th>Org</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>33</td>
<td>0</td>
<td></td>
<td>11</td>
<td>Wheat/Soybeans, no lodging...</td>
<td>1-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Organics</th>
<th>N</th>
<th>P2O5</th>
<th>K2O</th>
<th>Amount</th>
<th>Units</th>
<th>#</th>
<th>Incorp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ap1 Split 1</td>
<td>40</td>
<td>61</td>
<td>41</td>
<td>1.0</td>
<td>tons/A</td>
<td>1</td>
<td>&lt; 1 day</td>
</tr>
<tr>
<td>Ap1 Split 2</td>
<td>60</td>
<td>91</td>
<td>61</td>
<td>1.5</td>
<td>tons/A</td>
<td>1</td>
<td>&lt; 1 day</td>
</tr>
<tr>
<td>Ap1 Split 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Organics</td>
<td>100</td>
<td>152</td>
<td>102</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Fertilizer</td>
<td>Mg</td>
<td>Mn</td>
<td>Zn</td>
<td>S</td>
<td>B</td>
<td>Ca</td>
<td></td>
</tr>
<tr>
<td>broadcast/2nd Fall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>topdress</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
When all the recommendations for a field need no further adjustment, click the small box marked Lock at the center right of the page.

The lock will prevent additional changes to the recommendations for this field and retain existing adjustments for printing.
D. Successive Year Recommendations

NuMan Pro is designed to work on a single nutrient management planning year. Therefore, the currently opened file should address a single year in a nutrient management plan. Successive year recommendations must be treated with a series of individual plan files. Be sure to name these files accordingly so as not to confuse them with others of similar name. A good practice is to include the plan year in the name of the file.

For successive year recommendations, it is often easiest to update a copy of the existing file. Once the file for the first year of the plan is completed, make a copy of the file and rename the copied file to reflect the next year in the plan. The new file can then be edited to reflect changes and additions to accommodate different crops, the projected allowances for organic history information and any applicable crop nutrient credits.

Information in the PSI side of the file should be also checked and any necessary changes should be made.

When the file for the second year of the plan is completed, make a copy of this second file and repeat the process described above for the third year. Keep in mind the applicability of soil and manure analysis data. Be sure to update analysis information as necessary.
XIII. Printing Reports

All NuMan Pro recommendations and reports can be printed from the dropdown box on the File Menu. A subset of this information is also available using the Print icon on the Tool Bar.

Clicking Print from either location will open a Print List dialogue showing the list of currently available fields on the left. Choose fields for printing by moving them from the source list on the left into the target list on the right. Use the Add, Add All, Rem (remove) and Rem All (remove all) buttons in the middle to move files from one list to the other.

Fields will print on the order in which they are entered in the Target List. Make adjustments in the list for a logical presentation of fields before printing.

If you choose Add All, fields will be placed in the Target List as follows: field identified by numbers will be placed before fields whose identifiers start with letters; all fields whose identifiers start with the same number (1, 11, 12, for example) will be placed before the next number in a numerical sequence (such as 2).
Click the check boxes on the right to print some or all of the reports. Printouts are provided only for topics which have had information entered. For example, unless fertigation is used, fertigation recommendations will not print.

Field Information will print organic application history (where applicable) and other profile information for each selected field. Soil Test Analysis will print original test results and converted Fertility Index Values (FIV) for each selected field.

Notes will print notes pertaining to all crops for all selected fields. Each recommendation includes a list of note numbers, under the crop name, to associate with that crop.

If selected, PSI evaluations will be printed for each field that has the PSI component enabled even if PSI has not been completed. Incomplete PSI evaluations, therefore, may display erroneous data in the PSI report.

### A. Special Reports

Special reports may be printed by making the appropriate selection on the File menu. The Print ID, Print PSNT, Print Waste Balance and Print Organics selections present the user with sub-menus and additional print selections. The Print Watershed Acre Tally selection will print a report listing the quantity of acres farmed by watershed and further divided into New and Updated categories.

The Print ID sub-menu contains selections for printing the ID Summary and the Supplemental ID reports.

**ID Summary** will print a report listing all fields in the currently opened file and their associated Account ID numbers. The Supplemental ID selection will print a report listing each field that has Supplemental IDs. Fields with only a single ID number will not be part of this report. If all fields have only a single ID number, this report will not be printed.
PSNT opens a sub-menu with three options for the Pre-Sidedress Nitrate Test report.

**Blank Worksheet** prints a single worksheet page for hand calculation of the PSNT.

**Worksheet/Report** prints the PSNT records from the currently opened file that have been previously marked for printing by clicking **OK** on the PSNT dialogue.

**Report Summary** prints a summary PSNT report of the same set of fields available in the Worksheet/Report selection.

**Print Waste Balance** sub-menu contains selections for printing **Field Waste** and **Waste Utilization/Generation** summaries.

**Field Waste** prints a report of the organic materials and their allocation to the fields in the currently opened file. Each set of fields in the report will be listed chronologically. This report may also be used by the farmer as an organic material application schedule.

**Waste Utilization/Generation** produces either or both of two reports. During the print initialization process, all the organic materials in the file will be listed in the print dialogue. Select the organic material(s) to be included in the report(s) and check the box(es) in the lower right corner of the dialogue to indicate the desired report(s).

**Waste Utilization** generates a report showing each selected organic material and accounting for its utilization throughout the year. This report includes the initial amount, quantities generated, applied, exported and stored on a bi-weekly basis for the entire year. An accumulated total of each material applied is also provided.

The **Print Organics** sub-menu contains selections for printing the **Sludge History** and **Organics Analysis** reports.

The **Sludge History** selection will print a report containing fields in the currently opened file that have history records from Sewage Sludge applications. If no such history records exist, no report will be printed.

The **Organic Analysis** selection will print a report listing the analysis information of each organic material in the Organics Master List.

The **Print Watershed Acreage Tally** prints the number of new and updated acres per watershed for each file.
# XIV. Appendix - Tool Bar
The Tool Bar Buttons are described in the following table. Please note that some buttons may not be available in all operating components of the program.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong> button</td>
<td>deletes all information in all text boxes on all pages and return to the first page for starting a brand new document.</td>
</tr>
<tr>
<td><strong>Open</strong> button</td>
<td>invokes the typical Open dialogue and allows the user to navigate among directories if needed and select which file to open.</td>
</tr>
<tr>
<td><strong>Save</strong> button</td>
<td>writes all information in the currently opened file to disk memory. If the file does not already have a name, the user will be prompted to name the file.</td>
</tr>
<tr>
<td><strong>Print</strong> button</td>
<td>invokes the Print dialogue.</td>
</tr>
<tr>
<td><strong>Convert</strong> button</td>
<td>opens an existing NuManMD (.nmd) file and convert all or part of the fields into a NuMan Pro (.nmp) file or appends to an existing (.nmp) file.</td>
</tr>
<tr>
<td><strong>Add Field</strong> button</td>
<td>creates a new blank set of pages for an additional field within the loaded file.</td>
</tr>
<tr>
<td><strong>Extend</strong> button</td>
<td>duplicates one field's scenario information across several other fields.</td>
</tr>
<tr>
<td><strong>Delete Field</strong> button</td>
<td>deletes all components of the current field.</td>
</tr>
<tr>
<td><strong>Organics List</strong> button</td>
<td>adds or edits manure and sludge information for the current file.</td>
</tr>
<tr>
<td><strong>Manure Generation</strong> button</td>
<td>adds or edits information used to estimate manure production. (Or use Excel spreadsheets on the ANMP website.)</td>
</tr>
<tr>
<td><strong>Help</strong> button</td>
<td>launches web browser to bring up help document.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>NuMan</td>
<td>switches to the Nutrient Management view.</td>
</tr>
<tr>
<td>PSI</td>
<td>switches to Phosphorus Site Index view.</td>
</tr>
<tr>
<td>Balance</td>
<td>switches to Farm Balance view.</td>
</tr>
</tbody>
</table>

**Field Navigation** buttons - move through the list of fields. The inner two buttons advance (>>) or reverse (<<) one field at a time, in the order the field list was created. The outer two buttons jump to the first or the last field in the list.
XV. Appendix - Menus

The Menu Bar headings are File, Edit, Navigation, View, Window and Help. Descriptions of each menu’s contents are described below.

### File Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Convert (NuManMD file)</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Select Field Records</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Insert Consultant Info</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Save Consultant Info</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Print Setup</td>
<td></td>
</tr>
<tr>
<td>Print ID</td>
<td></td>
</tr>
<tr>
<td>Print PSNT</td>
<td></td>
</tr>
<tr>
<td>Print Waste Balance</td>
<td></td>
</tr>
<tr>
<td>Print Organics</td>
<td></td>
</tr>
<tr>
<td>Print Watershed Acre Tally</td>
<td></td>
</tr>
<tr>
<td>Default Directories</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

**New (Ctrl+N)** - creates a new blank document.

**Open (Ctrl+O)** - displays a list of available (.nmp file extension) files in the last accessed directory.

**Save (Ctrl+S)** - confirms a name before saving the (.nmp) file to the last accessed directory.

**Convert (NuManMD file)** - migrates data from existing NuManMD files (only .nmd files will be displayed) to the NuMan Pro file format.

**Select Field Records (Ctrl+L)** - displays list of fields for export from the currently opened file.

**Insert Consultant Info (Ctrl+Y)** - displays list of consultant registrar files (.nmc file extension).

**Save Consultant Info (Ctrl+U)** - provides a space to enter a name for the consultant’s registrar file (.nmc).

**Print (Ctrl+P)** - displays a list of fields available for printing within the current farmer’s file and offers several print options.
Print Setup - selects a printer (if there is more than one) to which the print jobs will be sent. Settings configured in this dialogue are valid for the current session of the program and will be reset to the system defaults upon exiting NuMan Pro.

Print ID, Print PSNT, Print Waste Balance and Print Organics - these print options have sub-menus and are discussed in the Special Reports section.

Print Watershed Acre Tally - prints a report totaling acres, new and updated, by county and watershed for the current file.

Default Directories - resets all directory paths to the program installation defaults. By default, the Field directory is within the NuMan Pro program directory unless changed by the user.

Exit - invokes the exit program dialogue for saving the file. Always save what is on screen before new blank, open existing or exit. If Warning Messages dialogue was disabled (View menu, uncheck warning messages), NuMan Pro will simply close discarding all unsaved data).

Print (Special Reports) – all print reports are accessible on the file menu, not all are on the add/remove print list from the printer icon.

Edit Menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Field</td>
<td>F9</td>
</tr>
<tr>
<td>Delete Field</td>
<td>F11</td>
</tr>
<tr>
<td>Copy Field</td>
<td>F3</td>
</tr>
<tr>
<td>Extend</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Lock All</td>
<td></td>
</tr>
<tr>
<td>Unlock All</td>
<td></td>
</tr>
<tr>
<td>Organics Master List</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Manure Generation</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Import Soil Analysis</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Import PSI Data</td>
<td>Ctrl+I</td>
</tr>
</tbody>
</table>

Add Field (F9) – adds a new blank field record to end of file.
Delete Field F11) – deletes current field record.
Copy Field (F3) – copies core field data including account ID, county, tract, and watershed.
Extend (Ctrl+E) – enables a special scenario function.
Lock All – prevents editing of all fields in the file.
Unlock All – allows editing of all fields in the file.
Organics Master List (Ctrl+G) – adds and edits listings for manure and other organic materials.
Manure Generation (Ctrl+D) – manure generation function.
Import Soil Analysis (Ctrl+A) - electronically imports data from soil testing laboratories.
Import PSI data (Ctrl+I) – invokes the Open dialogue (only .phid files will be displayed) where PSI data can be imported and merged with field records within the open NuMan Pro file.

**Navigation Menu**

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>F5</td>
</tr>
<tr>
<td>Previous</td>
<td>F6</td>
</tr>
<tr>
<td>Next</td>
<td>F7</td>
</tr>
<tr>
<td>Last</td>
<td>F8</td>
</tr>
<tr>
<td>Switch to NuMan view</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Switch to PSI view</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Switch to Balance</td>
<td>Ctrl+B</td>
</tr>
</tbody>
</table>

**First** (F5) – first field record.

**Previous** (F6) – previous field record.

**Next** (F7) – next field record.

**Last** (F8) – last field record.

**CTRL+W** – toggles between Nutrient Management (NuMan) view and Phosphorus Site Index (PSI) view.

**CTRL+B** - switches to Manure Balance view.

An alternative way to switch between views is to use the icons on the Tool Bar in which

- = NuMan, = Phosphorus Site Index, and = Manure Balance.

**View Menu**

- Status Bar
- Separate Navigation
- Warning messages
- Watershed Acre Tally
- Splash screen

Click a selection to enable or disable it. Each selection will display a check mark when enabled. NuMan Pro will save whatever settings were selected when the program was last exited, so they do not reset to default on start-up.

**Tool Bar** – toggles on and off the display of the tool bar.

**Status Bar** – toggles on and off the display of the status bar at bottom of the screen which describes icons and menu items.
Separate Navigation – toggles on and off the display of separate navigation. See Navigating Between Fields under the Navigation section, for more details on this feature.

Warning Messages – toggles on and off the message prompts to warn of potential data loss. It is strongly recommended to leave all warnings visible (i.e. checked) until very familiar with program, otherwise the user might inadvertently lose data. NuMan Pro saves settings from when last exited, so it does not reset to default on start-up.

Watershed Acre Tally – temporarily displays total, new and updated acres, by county and watershed within the current file. A check mark does not exist for the Watershed Acre Tally selection since clicking it will temporarily display the Watershed Acre Tally.

Help Menu

Some Help Topics will launch from the web browser.

NuMan Pro Web Site launches a web browser and links to latest information and updates about NuMan Pro on the University of Maryland Agricultural Nutrient Management Website.
XVI. Appendix - Keyboard Shortcuts

The cursor focus signifies the location where NuMan Pro is currently expecting input or action. If the focus is on a page tab, most of the keyboard commands will not produce the desired action, therefore, move the focus and proceed.

When main frame is active, ALT+(underlined letter in menu name) opens that menu.

When cursor is within a menu, Up Arrow or Down Arrow navigates the menu.

Tab – cycles through controls on each page or the main frame.

Arrow keys – navigate within grids.

When the cursor focus is within a drop-down list, Up Arrow or Down Arrow will open the drop-down list and then navigate the list.

PgUp or PgDn – exits a grid on any page.

Space Bar – activates all buttons, marks applicable grid cells on data pages and marks all check boxes.

Enter – activates menu options, selects list items and activates most buttons in dialogues.

ALT+F4 – exits NuMan Pro.

Ctrl+a – import electronic soil test data into NuMan Pro.

Ctrl+b – provides balance view.

Ctrl+c – copies text.

Ctrl+d – provides Manure Generation.

Ctrl+e – extends the current field scenario to additional fields.

Ctrl+g – provides the Organics Master List.

Ctrl+i – imports Phosphorus Site Index data (.phid files) into NuMan Pro.

Ctrl+l – selects Field Records to make into new or append to existing files.

Ctrl+n – creates a new blank NuMan Pro file.

Ctrl+o – opens an existing NuMan Pro file (.nmp).
Ctrl+p – prints all or part of a nutrient management plan.

Ctrl+s – saves the current file.

Ctrl+t – opens a NuManMD file (.nm_?) for conversion to NuMan Pro format (.nmp).

Ctrl+u – saves a consultant’s information as a (.nmc) file for future use.

Ctrl+w – toggles between the NuMan Pro view and the PSI view.

Ctrl+y – inserts a consultant’s previously saved information.

F3 – copies core data from current field and pastes into new field at the end of the open file.

F5 – displays first field in the file (according to the order they were created).

F6 – displays previous field in the file (according to the order created or added to the file).

F7 – displays next field in the file (according to the order created or added to the file).

F8 – displays last field in the file (according to the order created or added to the file).

F9 – creates a new blank field at the end of the currently open file.

F11 – deletes the currently displayed field.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>account ID</td>
<td>the 10-16 tax digit parcel identification number assigned to a property by the Maryland Department of Assessments and Taxation</td>
</tr>
<tr>
<td>blank field</td>
<td>a field record without any information</td>
</tr>
<tr>
<td>consultant registrar</td>
<td>stores and inserts a nutrient management consultant's certification and licensing information</td>
</tr>
<tr>
<td>core information</td>
<td>a limited set of four identification attributes for any one field (account ID, county, tract and watershed ID)</td>
</tr>
<tr>
<td>crop grid</td>
<td>a table display of a single crop, separated visually from other crops by a thickened, colored line or a double crop which is divided into two joined listings separated from other single or double crops by a thickened, colored line</td>
</tr>
<tr>
<td>current farmer’s file,</td>
<td>A farmer’s file that is opened within NuMan Pro and ready for data entry or editing</td>
</tr>
<tr>
<td>currently open or loaded</td>
<td></td>
</tr>
<tr>
<td>farmer’s file</td>
<td></td>
</tr>
<tr>
<td>current field,</td>
<td>the single field record that is presently displayed and ready for data entry or editing</td>
</tr>
<tr>
<td>currently displayed or</td>
<td></td>
</tr>
<tr>
<td>accessed field</td>
<td></td>
</tr>
<tr>
<td>currently active set of</td>
<td>all of the fields in an opened file</td>
</tr>
<tr>
<td>fields</td>
<td></td>
</tr>
<tr>
<td>directory</td>
<td>a computer's data storage area for related information</td>
</tr>
<tr>
<td>subdirectory</td>
<td>a directory inside of another directory</td>
</tr>
<tr>
<td>farmer ID</td>
<td>the farmer's MDA party ID number</td>
</tr>
<tr>
<td>field</td>
<td>one management unit</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>field record</td>
<td>all information pertaining to a single field with a unique combination of county, tract and field names</td>
</tr>
<tr>
<td>set of fields</td>
<td>any number of fields contained in one client's file</td>
</tr>
<tr>
<td>field number box</td>
<td>the two-celled indicator on the navigation bar showing the order number of the current field and the total number of fields in the current file</td>
</tr>
<tr>
<td>order number</td>
<td>an index value representing the placement of a given field within the natural order of fields in a given .nmp file</td>
</tr>
<tr>
<td>natural order</td>
<td>the order of sequence, or occurrence, of all of the fields within a given .nmp file</td>
</tr>
<tr>
<td>file naming convention</td>
<td>a user-defined set of guidelines for individual file identification</td>
</tr>
<tr>
<td>icon</td>
<td>a picture, used on a button or a tool bar, representing that item or function</td>
</tr>
<tr>
<td>UME</td>
<td>University of Maryland Extension</td>
</tr>
<tr>
<td>MDA</td>
<td>Maryland Department of Agriculture</td>
</tr>
<tr>
<td>MDE</td>
<td>Maryland Department of Environment</td>
</tr>
<tr>
<td>organics</td>
<td>any manure, sludge and/or other organic processing by-product</td>
</tr>
<tr>
<td>organics grid</td>
<td>a display of a single organic material (or package of up to three different organic materials) used to meet a crop's nutrient needs within a field</td>
</tr>
<tr>
<td>organics grid</td>
<td>the first reference number in the grid is the entity and the second number is the item reference number from the organics master list</td>
</tr>
</tbody>
</table>

111
organics master list  the repository for all organic material, and their analyses, that are available for allocation to fields in the currently opened file (the list is not cumulative across different client's files)

organics package  multiple organic materials used to meet any single crop's nutrient needs

parcel  name for any tract and field or any county, tract, and field

P Rem Plan (phosphorus removal plan)  either of two phosphorus-based plans (regular or transport) used on a field-by-field basis

Reg P Rem (regular phosphorus removal)  a procedure that limits the organic nutrient recommendation to the quantity of crop phosphorus removal based on the plant phosphorus removal per unit yield

Trns P Rem (transport manure phosphorus removal)  a procedure that limits the organic nutrient recommendation to the crop phosphorus removal (based on the plant phosphorus removal per unit yield) for up to three crops within 24 months when using poultry manure and for a single season when using other organic types

revert  restores previously entered, unedited data on a page if utilized before saving the file or before displaying a different field

scenario  the planned field activities for a single crop without any organic material or a combination of one crop and one organic material (or organic package)

primary scenario  the planned field activities (i.e. the scenario) that is indicated as the most likely to be implemented

scenario information  the component information such as yield goal, basis of organic recommendation, organic application rate, days to incorporation, mineralization rate, organic history data and any fine tuning on the recommendation page
special case scenario  a regular phosphorus removal plan or a transport manure phosphorus removal plan

separate navigation  separates the tract and field IDs into two lists with a hierarchical structure for ease of locating a single field or tract within a file

split manure application  an organic material allocated to a crop that agronomically dictates nitrogen applications at different times of the year and/or more than a single organic material listing to supply a crop's nutrient requirements

source list  a grouping of data storage items (e.g. fields, analyses, etc) that may be utilized for performing a variety of tasks

target list  a grouping of data receiving items (e.g. fields, waste materials, etc.) that may be utilized to receive data from destinated items on a source list for performing a variety of tasks
XVIII. Appendix – Technical

NuMan Pro will migrate data from files created with Nutrient Management for Maryland Professional Version 2.1, Nutrient Management for Maryland (NuManMD), as well as merge data from files created with the Maryland Phosphorus Site Index (PSI).

Available within NuMan Pro is the University of Maryland Extension publication "Maryland Phosphorus Site Index Technical Users Guide". To view this publication, select the previous link or the Maryland PSI Tech Users Guide option on the Help menu. The operating system will start the Internet browser and load the index page for this publication. The index page contains links to texts, topics and tables. Each link enables the user to access the publication at a different point. At the bottom of each page of the publication, arrows are provided to view the preceding or following page.

The most current information regarding NuMan Pro is available on the NuMan Pro Website. If there are any issues, file updates, or software releases, this site will contain information or instructions. The NuMan Pro Website may be directly accessed within the Help menu.

Other Nutrient Management information may be found at the University of Maryland Extension's Nutrient Management Program website that may be directly accessed by selecting the ANMP Website option within the Help menu. The operating system will start an Internet browser and, if the computer is connected to the Internet, the browser will be directed to the University of Maryland Extension Agricultural Nutrient Management Program home page.

A. Updating from older versions

Updates are available from the NuMan Pro Software website.

- Click on the NuMan Pro update link.
- A dialogue will appear giving the option to "Run or Save" the file.
- Select Save and choose a location where it will be easy to locate later (the desktop is a suggestion).
- When the download has completed, close the browser and all other programs that may be running.
- Locate and double-click on the downloaded file to start the file-unzip program.
- The default installation path will be indicated to the target location. If necessary, change the target location to reflect the actual installation path of the NuMan Pro software.
- Click the UNZIP button. The unzip program will place the files in the target location.
- When unzip is complete, click **OK** and then click **Close**. When the unzip program closes, the downloaded file may be removed from the desktop (if it was saved there). Either delete it or move it to another location on the computer's hard drive.

### B. Converting NuManMD Files

Data files (files with a .nmd file extension) saved within NuManMD software may be converted into NuMan Pro files (files with an nmp file extension). The conversion process is necessary because of differing file formats between the two programs.

Click the **Convert** icon from the menu bar or select the **Convert (NuManMD File)** option from the **File** menu or use the keyboard shortcut **CTRL+T**. The **Open** dialogue will appear. If necessary navigate to the directory containing the NuManMD files (.nmd). The default path to this directory is `C:\Program Files\University of Maryland\NuManMD\Fields`. If the default installation path was not used, the actual path should be indicated.

Select and open the desired NuManMD file (.nmd). The **Select Item** dialogue will appear and display two lists. On the left will be the fields contained in the NuManMD file (the source list). On the right will be an empty target list.

Select the desired field listings from the source list then click **Add** to copy them into the target list. Use **Add All** if all fields are to be selected.

If the field records are to be in a new file, use the **Save List** button. If the field records are to be made part of an existing file, use the **Append** button. Either choice will invoke the **Save As** dialogue.

The original NuManMD (.nmd) file name will appear in the file name box by default with a new (.nmp) extension. Use this name, edit the name, or select one of the existing files listed above in the dialogue. When the appropriate name corrections are complete, select **Save**. If the user selects a file name that already exists, a message will confirm whether to overwrite the existing file. When using **Save List**, this process will completely overwrite any existing NuMan Pro files with the same name and all previous data will be lost. When using **Append**, the existing files within the target directory will not be impacted and the appended fields will appear at the end of the list in the file.
C. Importing PSI Data

Data in files created and saved by the stand alone Phosphorus Site Index (PSI) software may be imported into NuMan Pro. The Import PSI Data function does not modify any portion of the original PSI file (.phid).

Select the Import PSI Data option from the File menu (or CTRL+I). The Open dialogue will appear. Navigate to the directory containing the PSI files (.phid extension). The default path to this directory is C:\Program Files\UofM\PSI\Fields. If the default installation path was not used, the actual path will be different.

Select and open the desired PSI file (.phid). The Select Item dialogue will appear and display two lists. The items in each list are defined by county abbreviation followed by tract ID and then field ID. On the left will be the fields contained in the PSI file (the source list). On the right will be the fields contained in the NuMan Pro file (the target list). The two lists, most likely, will not be the same because not all fields require the PSI. Therefore there will be fields in the list on the right that do not have corresponding items in the list on the left.

Drag and drop items from the source list into the corresponding item in the target list. The listings will not actually move but a copy of each dragged item will appear in the target list next to the item to which it is now linked. **

** The process of linking PSI items to NuMan Pro field records can also be done with the use of keyboard commands. The Ctrl key will select a PSI item for linking. The Arrow keys will navigate between and within both lists. The Space Bar will deposit an item in place. The Shift key will select a PSI item, in the Target List, for moving within the Target List.

After all selections are made for linking, click the OK button. The PSI data will be inserted into the appropriate field records within the NuMan Pro file. The County, Watershed and Mapunit information, on the Field page in the NuMan Pro file, will be over-written with the information from the PSI file.

Items in the source list can be linked to more than one item in the target list. Drag and drop a PSI list item from either list into the row next to an item in the target list. If a PSI item within the target list needs to be moved, right-click, drag and drop it from one item in the target list to a new item in the target list. If a PSI item within the target list needs to be unlinked, highlight it to select it and then click the Unlink button. The PSI item will be removed from the target list.
D. Memory/Allocation of RAM

An explanation of how NuMan Pro allocates RAM (random access memory) may be helpful to aid in understanding when edited data are updated and provide a foundation on which to form a set of personal preferences for saving, and thereby not losing work.

Whenever NuMan Pro is started, an initial empty virtual file is created in memory. By opening an existing file, this virtual file (or any previously open file) is discarded and replaced with the information from the currently opened file that is saved on the hard drive. Before the data fields in an empty virtual file are populated with data or an existing opened file is edited, the entire file is copied to system memory (RAM). A copy of the data for each field (only while that field is accessed) is also placed in a separate buffer space in memory. The accessed field's information is displayed one page at a time through the computer's video memory. What is actually edited is the page of information in video memory. The edited information replaces the information in memory when another page of data is displayed. When another field is accessed, the information for the currently accessed field in the buffer space is erased, before actually displaying the new field. When this new field is displayed, a copy of the information for this field is placed in the buffer space as well as being displayed through video memory one page at a time on the monitor.

If while editing any one field, and before any other field is accessed, the information for all pages for the current field can be restored to its pre-edited state by using the Revert button near the bottom right of the Field page. Most individual pages may be restored, with the same limitations, by using the Revert button near the bottom right of most Data Entry Pages. If there is no Revert button on the page, the function is not available for this individual page.

Warning Messages are displayed at several points within NuMan Pro to avoid data loss. These messages can be annoying to some users, therefore, the Warning Messages may be disabled by checking the Warning Messages option within the View menu. It is suggested that the user regularly save file information if the Warning Messages are disabled. The Warning Messages may be restored for future use by unchecking the Warning Messages option within the View menu.